Scripting and Programming for Modeling, Simulation, and Control

Copyright © Bruce Char,
2008-09
Contents

1 Introduction -- Technical computing at the turn of the century ................................................................. vii
  1.1 Chapter synopsis ................................................................................................................................. 1
  1.2 What is technical computing? What kinds of technical computing are there? ...................................... 1
  1.3 What are the advantages of doing technical calculation with a computer? ........................................... 1
  1.4 The spectrum of devices for technical computing ...
    Personal computers ..................................................................................................................................... 2
    Hand held or mobile devices ................................................................................................................... 3
    Dedicated controllers .............................................................................................................................. 4
  1.5 Maple, a system for technical computing ............................................................................................. 4
  1.6 What about Systems X, Y, Z, ...? ........................................................................................................ 5
  1.7 Why pick Maple as the first system? ..................................................................................................... 5
  1.8 For the curious: using more than one system ..................................................................................... 6
2 Getting started with Maple's Document Mode: doing technical work with a clickable interface ............... 7
  2.1 Chapter synopsis .................................................................................................................................. 7
  2.2 A new document .................................................................................................................................. 7
  2.3 Exact arithmetic .................................................................................................................................... 8
    Grade school arithmetic .......................................................................................................................... 8
    Making typographical mistakes ............................................................................................................. 11
    Correcting typographical mistakes ........................................................................................................ 13
    Exponentiation (powers). Numbers with lots of digits ......................................................................... 14
    Detecting and fixing vocabulary and "logic" mistakes ......................................................................... 15
  2.4 Saving and retrieving your work ......................................................................................................... 16
  2.5 Retrieving backups ............................................................................................................................. 17
  2.6 Algebra, plotting and mouse-clickable operations ................................................................................ 18
    Algebraic expressions and equations. Solving equations. Working with pieces of expressions. ............... 18
    For the previously experienced: some things are different, for a reason ................................................ 18
    Plotting and approximate numerical solutions ..................................................................................... 19
    The Expressions Palette and the Common Symbols Palette: entering Trigs, logs, roots, exponentials ....... 22
    Approximate numerical (calculator - type) arithmetic in Maple ............................................................ 23
    Evaluation at a point, and selection of pieces .......................................................................................... 24
  2.7 A quick-reference summary to this chapter ........................................................................................ 25
3 Chapter 3 Exact and limited-precision (floating point) numbers ............................................................... 31
  3.1 Chapter Overview ................................................................................................................................. 31
  3.2 Exact arithmetic with exact numbers ................................................................................................... 31
  3.3 Limited-precision (calculator-style) arithmetic with limited-precision numbers. ................................. 33
  3.4 Maple will decide what kind of arithmetic to use by how numbers look ............................................. 35
  3.5 Differences between limited-precision numbers in Maple and in math textbooks ............................. 36
  3.6 Which kind of numbers and arithmetic should I use? ......................................................................... 39
  3.7 Summary of Chapter 3 material ........................................................................................................ 39
4 Chapter 4 Words, labels, assignments, and scripts .................................................................................... 41
  4.1 Chapter Overview ................................................................................................................................. 41
  4.2 Maple as a word processor .................................................................................................................. 41
  4.3 Labels and assignments: remembering results for future use. ............................................................ 42
    Labels ...................................................................................................................................................... 42
    Assignment to a name, evaluation .......................................................................................................... 43
  4.4 The structure of information in Maple: getting information from solve ............................................. 45
  4.5 Scripting: creating computational work in reusable form ..................................................................... 47
  4.6 Rewriting the script using labeling and assignment ............................................................................. 49
  4.7 Summary of script writing .................................................................................................................. 50
List of Tables

An early computer ............................................................................................................................... 2
A high-end calculator in 2009 ................................................................................................................ 4
Maple started up with new document in Windows XP .......................................................................... 7
Maple document with first entry area ........................................................................................................ 8
Math input using 2D Math ..................................................................................................................... 8
Math input with labeled result ................................................................................................................ 8
Arithmetic operations in Maple .............................................................................................................. 9
Some examples of Maple error messages ............................................................................................... 12
Create Document Block to force a Math input area wherever the cursor is placed ................................... 14
Example of a vocabulary mistake .......................................................................................................... 15
Maple save menu operation .................................................................................................................. 16
Maple save dialog box (Windows XP) .................................................................................................. 17
The Maple state display ....................................................................................................................... 17
Example of plotting ............................................................................................................................ 20
Plot created by right-click -> Plot -> 2DPlot. .......................................................................................... 20
User-configured plot using PlotBuilder instead of 2DPlot ..................................................................... 21
The Expression palette. The top of the "Common Symbols" palette is also visible at the bottom of the picture ... 22
Examples of palette-driven computation ............................................................................................... 23
Examples of computing with approximate solving ................................................................................ 23
Evaluate at a point .............................................................................................................................. 24
Operations on equations ....................................................................................................................... 24
Some exact numbers ........................................................................................................................... 31
Exact arithmetic is always exact ............................................................................................................ 32
Limited-precision (floating point) numbers ............................................................................................. 33
Limited-precision (floating point) arithmetic ........................................................................................... 34
Two expressions factored ..................................................................................................................... 36
Two equations with "numerical solve" .................................................................................................... 36
Contrasting approximate and exact arithmetic ....................................................................................... 38
Document after control-T (or Insert->Text). .......................................................................................... 41
Document with a mixture of text and math .............................................................................................. 42
control-= puts the results of a calculation in the midst of text. ..................................................................... 42
Labeled results ................................................................................................................................... 43
Assignment ....................................................................................................................................... 44
= and := mean different things in Maple .............................................................................................. 45
Basic data structures in Maple .............................................................................................................. 46
To our colleagues and families, who supported us in trail-breaking.

To our students, who learn how to work with the new and different.
1 Introduction -- Technical computing at the turn of the century

1.1 Chapter synopsis

1. We explain what technical computing is about, why it's done with a machine and what kinds of devices are used to do it.

2. The advantages doing calculation with a computer are surveyed.

3. Maple, a system for technical computing is introduced and contrasted with some of the other choices available today.

1.2 What is technical computing? What kinds of technical computing are there?

Well, obviously, it's "computing done for technical work" -- primarily science and engineering, but any other field where mathematical and scientific reasoning is used, which nowadays can include other fields such as finance and business, medicine, or digital media. The success of such reasoning in these fields is well-known. Students of those fields need to become experienced and develop proficiency in how it's done to be able to obtain success in the same way.

You are probably familiar with numerical computing since it's done even without computers, with paper and pencil or with calculators in high school or even earlier. You probably have also seen graphing calculators do simple kinds of graphical computing, also sometimes known as mathematical visualization. In addition to this, computers can and are used to do algebraic computing -- computing where the answer is a formula rather than a number, as well as deductive or logical computing -- using logic or deduction to find answers.

In this course, we will concentrate on numerical, symbolic and graphical computing, although we will see some instances of deductive computing as well.

1.3 What are the advantages of doing technical calculation with a computer?

One advantage is greater quantity of calculation -- computers can do calculations billions of times faster than humans and thousands or millions of times faster than calculator-driven computation. Using them makes some things feasible that are not possible any other way: As you've seen with your high school physics, chemistry, and math courses, scientists and engineers often work with mathematical models -- systems of equations, symbols, and mathematical relations that try to describe key aspects of a situation. Calculation with models helps answer questions about the situation being modeled: How much fuel will be used in this operating scenario? How long will it take to heat up the furnace to 265 degrees? Computer simulation loads a model with some initial conditions, and then through calculation produces predictive results. Simulation can be used to make forecasts such as: how fast will the vehicle be moving after 5 seconds? How far will the pollutants move underground after being buried five years?

Computers make it possible to use models that require much more extensive calculations to reach conclusions. The payoff may be better predictions. Extensive calculation also makes it possible to generate and present more information. Computer visualization goes beyond that to highly detailed pictures or animations of a situation described through a mathematical model. This can lead to better insight and understanding.

Another advantage is that it is easier to make a lasting written record of the work. One of the big differences between professional technical work and homework is that the modeling and calculation has lasting value: it matters to more than one or two people, and it is being used in an on-going project. In a professional situation, a worker may need to go back and review the work a year later, long after the details are faded from easy recall. Other people may want to reuse the programming and will need to be given an explanation about how to use it. Since they have long-term value,
it is beneficial to put them into a form suitable for easy future reference and reuse. Thus the work typically includes both programming and documentary explanation.

1.4 The spectrum of devices for technical computing

Back in the days of the original electronic computers developed during and immediately after World War II, the only kind of device you could use for technical computing (which was the only computing that could be justified in those days) filled up a whole room and needed an extensive staff to support.

An early computer

![ENIAC](ENIAC, one of the first electronic computers, being programmed by Herman Goldstine at the University of Pennsylvania circa 1946. (US Army photo) Originally intended to do artillery calculations, it was used for the design and development of the first thermonuclear weapons. See [http://www.seas.upenn.edu/~museum/](http://www.seas.upenn.edu/~museum/).

Today's users have a choice of a wide variety of devices:

**Personal computers**

Typically a computer for individual use can be expected to have the following features:

Processing capability of a billion or more arithmetic or memory operations per second. Significant amounts of calculation are used in doing the graphics involved in processing digital media or supporting the artificial worlds presented in computer games. This same power can be used to do the simulation and exploration in many common kinds of scientific and engineering situations. This course is about using that calculation power.

Standard selection and pointing devices, keyboard and mice. Some computers support "tablet" operation which allow use of a pen writing on the display. The display area and input devices make it easy to enter information via text or by pointing/selection. While the World wide Web has made much processing possible with just "pointing and clicking", the complexity and mathematical sophistication of the models used in current technical computing outstrip the capabilities of current "point and click" technology. Some (computer programming) language-based interaction is necessary to handle things deftly. This requires a more knowledgeable user, but many people find that the extra power is worth the learning effort.

A screen capable of display information equivalent to one or more 8 1/2 x 11 inch pieces of paper. This helps support the development of documentation, or of more complex visualizations.

Local storage capable of storing a significant fraction of the text of the books in the Library of Congress. Of course, it's easy for a personal media collection to fill up this kind of storage, but it should not be forgotten that the billions of characters that this storage represents can store years or decades of efforts of computer programmers.
Connection to the internet, which makes it easier to communicate and share work with others, and to download new programming. From the viewpoint of technical computing, that it's easy to import and run substantial amounts of programming.

**High performance computers, also known as "supercomputers"**

While hand held devices and personal computers are used widely by the general public for non-technical purposes, there are a class of computers that are used primarily for mathematically-based computing. Typically instead of billions of numerical operations per second ("gigaflops" -- billions of floating point operations), they employ multiple processors in parallel to do trillions of operations ("teraflops") or quadrillions ("petaflops"). The hardware, personnel and energy costs of such computers are significant, so typically they are available through centers used through the Internet from many locations. The kinds of technical problems such devices are used for would include: simulation of complicated physical situations, such as for climate prediction, astrophysics, or engineering design (aircraft, groundwater, large building, automobile).

Using such large devices incur significant expense, from hardware, software and support staff costs, as well as electrical power consumed. For example, the U.S. Department of Energy has an IBM computer at its Los Alamos National Laboratory in New Mexico, USA capable of 1 quadrillion (10^15) numerical operations per second. It consumes 2345.50 kilowatts when it is running. (reference: [http://blog.enterprisefl.com/green/blog/2008/06/green-petaflop-ibms-roadrunner-wins-supercomputer-top-spot.html](http://blog.enterprisefl.com/green/blog/2008/06/green-petaflop-ibms-roadrunner-wins-supercomputer-top-spot.html)) The National Center for Computational Sciences (NCCS) at Oak Ridge National Laboratory in Tennessee, USA which has several large supercomputers, has a 2008 annual budget between $80 million and $100 million. (reference: [http://news.cnet.com/8301-13772_3-9985500-52.html](http://news.cnet.com/8301-13772_3-9985500-52.html)). A typical personal computer might be capable of approximately 4 billion numerical operations per second, so the Blue Gene computer at Los Alamos provides roughly 0.25 x 10^6 = 250,000 times more computing power.

Typically the programming is developed on personal computers, then moved to the larger devices. Usually the expensive supercomputer time is spent primarily on numerical computation, rather than on providing a nice-to-use interface for users. However, the results of a supercomputer may be shipped over the Internet to a personal computer so that a scientist or engineer may mull over the results in a more contemplative way without incurring additional supercomputer costs.

Multiple computers may be linked together over the Internet to get all the pieces of a particular elaborate computation done. This may have the supercomputers performing the massive numerical computations, while other smaller or personal computers linked in may be displaying the results to a distributed team of investigators who are collectively digesting results and steering the on-going work.

**Hand held or mobile devices**

**Calculators** are useful for casual computation, where one wants to figure out the solution to a small problem once. It's easy to punch in a few numbers and operations and to read the answer on the display. As inexpensive and small mobile devices, these are typically more limited in:

1. memory (limits to computation size and to built-in features)
2. energy consumption (slower processor speed)
3. form factor (keyboard and display too small for more than casual technical use)

Typically calculators are not networked, making it harder to share results to transfer them elsewhere to continue the work.
A high-end calculator in 2009

The TI-Nspire with CAS is a recent generation calculator from Texas Instruments. It can do numerical and symbolic calculations, as well as graphing. According to ticalc.org (http://www.ticalc.org/basics/calculators/ti-nspire-cas.html) it has 16Mb memory, 20Mb storage and has a 150MHz processor. This makes it have about 100 times less memory, 8000 times less storage, and is about twenty times slower than a typical laptop with a dual core 1.5GHz processor, 2Gb memory, and 160Gb disk. Its screen is 240 x 320 pixels, giving it about twenty times less display area than a typical laptop. This is one of the first generation of calculators with limited wireless networking available as an add-on.


Smartphones, personal digital assistants (PDAs), media players have in theory the same processing capabilities as calculators although most of them are not used extensively for technical computation. One advantage of these kinds of devices is that are typically networked so that it's possible to get a more powerful computer somewhere else in the Internet "cloud" of computational resources to do some of the work.

In the future there may be more convergence of the capabilities of all "mobile small form factor" devices. However the small form factor and the limits to energy consumption will probably continue to constrain the capabilities of such devices compared to larger ones.

Dedicated controllers

Even some kinds of toasters have microprocessors in them nowadays. "Smart homes" may network many appliances and home features such as HVAC and lighting control. While these devices are merely configured rather than programmed by end users, students of technical computing should not forget that this is another place where programming is necessary. The economic reasons for switching to computer control of devices appear to be the greater flexibility and variety of control that can be developed at modest cost through programming for many kinds of devices. The kind of programming done for device control often has a mathematical basis. Although the processors in dedicated devices are typically a few orders of magnitude slower than those of personal computers or even smartphones, the programming languages used for them are often the same or similar to those used in personal computing.

1.5 Maple, a system for technical computing

In this course, you will learn how to do various kinds of technical tasks using Maple. The first version of Maple was developed in the early 1980s at the University of Waterloo in Ontario, Canada, but has since undergone many refinements and extension. (In Fall 2009, we will be using Maple 13.) Maple's original emphasis was on algebraic computing, so it was used by those who needed formulas as results for their work. In the early '90s it was used extensively in calculus classes as a way of supporting exploratory experimentation and more extensive experience with "applied" problems. More recently it has expanded its domain into the symbolic, numeric, and graphical calculations done more generally in scientific and engineering modeling and simulation.

Today, Maple supports numerical computing and graphical visualization about as well as it does symbolic computing. It has its own programming language but also has ways of doing calculations through the graphical user interface (GUI) that are a kind of augmented "point and click". The default way of interacting with Maple also allows you to mix documentation and computing instructions and results. Thus it's particularly easy in Maple to produce documents
that produce a well-documented solution -- a description of the problem, the explanation for how to solve it, and the computations that produce the details of the answer and evidence to justify its correctness.

1.6 What about Systems X, Y, Z, ...?

There are a variety of systems and programming languages used for technical computing nowadays. In a large technical establishment such as a university or research lab, one might find, in addition to Maple the use of systems such as: Python, Matlab, C, Mathematica, , Java, Octave, Macsyma, Sage, Axiom, or Fortran.

The vast array of tasks computers can be used for, the multiplicity of philosophies of system design, and the rapid and unrelenting nature of progress in computing means that there is no "best system" for any situation. Each system has its technical strengths. There may also be historical, cultural, or economic reasons why certain systems are used in certain places which co-exist with the technical justification. As with all popular and demanding activities, there are many products in use.

One important ramification of this is that students in technical fields must expect to become familiar and proficient in more than one programming system. Studying more than one brings greater knowledge of what's possible, and the advantages in judgment that comes from knowledge of diverse ways of achieving a goal. It also allows one to function effectively as a team member in larger cross-organizational efforts and to better to cope with the diversity in computing cultures that's out there.

1.7 Why pick Maple as the first system?

1. It is an interactive system, facilitating quick exploration of new ideas. Compared to languages such as C++ or Java, one can immediately start up an interactive system and get calculation results. It's also possible to enter computational scripts, which are sequences of steps that are less elaborate to set up than programs. The scripts can be easily re-run to do "what if" exploration just by changing a line or two in the script. The worksheet interface to Maple allows sophisticated mathematical typography and graphics as well as mouse- and palette-driven input.

2. It can handle calculations with formulas. Rather than figuring out the formula yourself, you can even get Maple to calculate the formula for you. While many mathematical calculations produce numerical results, formulas are needed to specify how those results are produced. Designers or developers often need to find and create the formulas rather than to just copy them from a book. A system where formulas are easy to represent and easy to create supports this kind of work. A system that allows you to represent and calculate both numbers and formulas makes it easier to do and document technical calculation than a system that just works with numbers.

3. It supports a variety of data structures that support technical computation: formulas, equations, functions, sets, lists, tables, vectors, and matrices. Rather than having calculations done with a number of digits that's fixed forever, it is easy to change the precision if more (or less) precision is needed. Having higher-level interaction with the computer is usually more productive of human time. Having all of these entities as "first class entities" in the system requires less mental effort by the user, since they do not have to translate what they are thinking about (e.g. a table of formulas) into the terms that the computer is using. Rather, the computer language accommodates the human style of thought.

4. It supports documentation as well as calculation. From the instructor's point of view, it's easier to create documents that explain Maple because we can use Maple both to handle the calculation and the presentation of results. For students, having a file with both the directions that cause the computation and the results makes it easier to present the work cleanly for grading, and for future reference. For professionals doing technical work, having an integrated environment where text, programming and results can be presented together can be a convenience.

5. It has a "conventional programming language". An objective of this course is to make you become familiar enough with some of the standard elements of programming (e.g. assignments, conditionals, loops, procedure definitions) so that you can use them creatively to handle certain common situations that can't be handled through point-and-click or built-in operations. These elements will be found in highly similar form in the languages used by many other systems used for technical work.
6. **The mathematics of modeling and simulation is an explicit feature of the language.** While its programming language is conventional, Maple's language has an important added plus -- you can work over expressions, equations, functions, and other mathematical objects just as conveniently as if they were numbers or characters. Conventional languages (e.g. Java) can represent arithmetic operations -- multiplication, addition, subtraction, and division -- but after that there are special tricks and conversions that you must perform to bridge the gap between what is written in the program, and the mathematical ideas that you are trying to use in the model. It's more straightforward in Maple to represent the mathematical model and the computation based on it. This ease of expression and comprehension by programmers -- has a hard-headed dollars and sense payoff. Less programmer time can be spent developing a computation. There is also an efficiency advantage to explicit representation of formulae: it is possible to use systems such as Maple to automatically improve the quality and efficiency of simulation calculations. This again leads to lower costs of doing the work. We think this is a software engineering advantage: it's cheaper in the long run to do technical work with languages with such features. We believe that most languages supporting technical work will have such functionality built-in into them.

1.8 **For the curious: using more than one system**

Any user of computers who expects to use them professionally for design and investigation must expect to eventually learn multiple systems. Using computer applications for work is like using tools in a workshop-- you would not expect to use one tool to do all tasks, even if the tool, like Maple, has "Swiss Army Knife" capabilities. Features that make it easier to do certain kinds of things may slow down doing other things. Even when systems overlap in features, they typically have differing philosophies and different technical strengths, which means that certain kinds of work may be significantly easier in one system than another. For example, developing something in Mathematica or Maple may be fine and quick for a personal computer, but making the same programming work on a supercomputer may take a lot of effort. Systems with major development effort behind them (such as Maple and those mentioned in the "section above) seem to have many similarities and functionality. If major effort were needed to acquire expertise in multiple technical applications, then prospects would be grim for the computing public. What makes things work out is this: at the introductory level, the difference between casual computing and professional technical computing is the style of working (higher emphasis on documentation, justification and ease of reuse), and the use of language-based commands/programming needed to do the more sophisticated operations in technical work. "Crossing over" means getting over the hurdles of learning the new style of work, and interacting with computers using computer languages. Once this hurdle is passed, it should take only incremental effort to acquire expertise in the second, third, or $n$th technical system. Having formal instruction on the first system should provide an explicit introduction into the concepts and the work processes to facilitate this.

Most systems realize that they cannot be the sole provider of technical computing services. If Institution A uses Mathematica and Institution B uses Python for their work, then if they expect to use each other's efforts, there has to be a way of interconnecting programs written in one system with that of another. Thus most systems have interconnections. For example, the Matlab Symbolic Toolkit allows Matlab users to call Maple to do formula manipulation. Similarly, Maple users can link to Matlab and run a Matlab program they've gotten from a colleague as part of a problem-solving process written in Maple.

Thus: knowledge of basic programming and the concepts of software development make it possible to switch between systems with only a modest amount of additional effort. Software interconnection allows one to use efforts done by others in another system without having to translate. Symbolic computation systems like Maple also have the additional bonus of being able to translate some of their programming between languages. There is a "convert-to-Matlab" feature for example, or a "convert-to-C" feature. This conversion doesn't work for computations involving formula manipulation because C doesn't have that feature. But the conversion does work for other kinds of computations involving just numbers or text.
2 Getting started with Maple's Document Mode: doing technical work with a clickable interface

2.1 Chapter synopsis

1. How to start up Maple and perform simple calculations, algebra, and plots within it.
2. Detecting and fixing typographical mistakes.
3. Introducing mistakes caused by vocabulary misunderstandings and the use of incorrect logic in giving directions.
2. How to save Maple work so that you can refer to it or resume working on it later.
3. How to recover a Maple worksheet if it or your computer crashes.

2.2 A new document

Start up the Maple application (this varies on the type of computer system you have, typically it involves clicking or double-clicking on the Maple 13 icon, but if you can't figure it out yourself ask for a demo for someone who knows). Once the Maple application window appears, a new "document" will appear in the main working area of the Maple application. A flashing cursor will appear with the outline of a small rectangle with dashed lines. The entry mode will read "Math" and "2D Math". You can make the "quick help" black box disappear by clicking on the "close box" circle-X in the upper right hand corner.

Maple started up with new document in Windows XP

After you close the quick help box, you will see the Maple cursor in a small rectangle with a dashed line outline.
At this point, what you type will appear in the small rectangle and be regarded as a mathematical expression. In the next section, we describe what to type in order to get something useful to happen.

### 2.3 Exact arithmetic

#### Grade school arithmetic

In the math area, type $2 + 3$. "$2 + 3$" is regarded as a mathematical expression by Maple when you type it into the dashed rectangle. As you are typing, the input indicators should say that you are entering Math mode, in "2D Math" input:

**Math input using 2D Math**

This expression should show up in the work area. If you hit the enter key, then Maple will evaluate the expression and you should see the result displayed below the input, as in the figure below:

**Math input with labeled result**
Maple has automatically calculated the answer and given it a label (1). After Maple calculates the answer, the cursor should appear below the result in another dashed-line rectangle. This indicates that Maple is ready to do another calculation. Maple supports all the basic arithmetic operations in a fashion similar to many other programming languages. One thing that takes some getting used to is that * (asterisk) is used to input multiplication rather than "x" or a centered dot. Another thing that takes some getting used to is that what you type is formatted to look like math notation. Thus if you type a /, Maple understands that you are talking about division and immediately starts formatting your input as if it were a fraction. If you type an asterisk, Maple formats that into a dot (·). There is also formatting that occurs with caret (^) since that is the way you enter an exponent in Maple.

### Arithmetic operations in Maple

<table>
<thead>
<tr>
<th>Operation</th>
<th>Character to type/character name</th>
<th>Notes</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>addition</td>
<td></td>
<td></td>
<td>2 + 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>multiplication</td>
<td>* (&quot;asterisk&quot;)</td>
<td>Typing an asterisk makes a center dot (·) appear in the displayed expression.</td>
<td>2 · 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>division</td>
<td>/ (&quot;slash&quot;)</td>
<td>Typing a slash draws a baseline and then positions the cursor in the denominator. Subsequent typing appears in the denominator. To get out of the denominator and return to normal typing, use the right-arrow key (→). Multiple divisions are by default conducted left-to-right.</td>
<td>2/6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1/3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5/3</td>
</tr>
<tr>
<td>subtraction</td>
<td>- (&quot;dash&quot; or &quot;hyphen&quot;, typically on the same keyboard key as the underscore. Dash and underscore do not mean the same thing.)</td>
<td>Multiple subtractions are conducted leftmost first.</td>
<td>3 − 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>−2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 − 5 − 7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>−9</td>
</tr>
<tr>
<td>parentheses</td>
<td>( , ) (&quot;left parenthesis&quot;, &quot;right parenthesis&quot;)</td>
<td>Use parentheses to change the order of calculation. They are also good for removing any guesswork by the reader as the order of operations.</td>
<td>(2 + 3) · 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 − \left( 5 - \left( \frac{2}{6} \right) \right)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>−29/15</td>
</tr>
</tbody>
</table>
negation  - ("dash" or "hyphen", typically on the same keyboard key as the underscore). This is the same symbol as used for subtraction.  

|  |  
|---|---|
| Put a dash in front of a number or parenthesized expression to negate it. | 
| \((3.5 - 2)\) | 
| -13 | (2.9) |

power  ^ ("caret", typically on the same keyboard key as the number 6)  

|  |  
|---|---|
| Typing a caret moves the cursor to the exponent position. Subsequent typing appears in the exponent. To get out of the exponent and return to the baseline, use the right-arrow key (→). | 
| \(2^3\) | 
| 8 | (2.10) |
| \(2^3 - 5\) | 
| \(\frac{1}{4}\) | (2.11) |
| \(2^{2-1}\) | 
| \(\sqrt{2}\) | (2.12) |
| \(2^{-2} + \frac{4}{5}\) | 
| \(\frac{21}{20}\) | (2.13) |

factorial  ! ("exclamation mark", typically on the same key as the number 1.)  

|  |  
|---|---|
| \(n!\) is the product of all the integers between 1 and \(n\). It is useful in computations that compute the number of possible ways that something could happen. For example, the number of possible orderings of a deck of playing cards is \(52!\) | 
| \(4!\) | 
| 24 | (2.14) |
| \((31)!\) | 
| 720 | (2.15) |
| \(52!\) | 
| \(80658175170943878571\) | (2.16) |
| \(6606368564037669\) | 
| \(7528950544088327\) | 
| \(782400000000000\) | 

Let's try out some of these operations. We can enter a sum of two fractions by using "+" and "/". If we type "2/3→+5/6 enter", this is what we see:  

\[
\frac{2}{3} + \frac{5}{6} = \frac{3}{2}
\] (2.17)
from the numerator and denominator. Now let's do a multiplication. The Maple programming language (like most) uses an asterisk * as the symbol for multiplication. However, Maple displays the expression with a centered dot. This may be disconcerting -- what you type is not what you see. When you are in "math mode" Maple will be using fancy typography to display whatever math you are entering. We'll see more of this shortly. See if you can reproduce this result:

\[ 2 \cdot 3 \]

\[ 6 \]  

(2.18)

We can mix operations. Try to enter and calculate the following:

\[ 1 + \frac{2}{3 + 4} + 5 \cdot 6 + 7 \]

\[ \frac{67}{14} \]  

(2.19)

In order to get that last denominator, we had to select the expression we had entered for the numerator with the mouse, so that the entire contents of the entry rectangle were blue. Then we typed a slash and the denominator appeared beneath it all. An alternative to using the mouse to enter expression (1.2.1.18) would be to use parentheses. If we type "(1+2/3+4→+5*6+7)/8 enter" we will see this:

\[ \left( 1 + \frac{2}{3 + 4} + 5 \cdot 6 + 7 \right) \]

\[ \frac{67}{14} \]  

(2.20)

This allows you to enter complicated expressions without having to use the mouse. Of course, the mouse is still necessary if you want to go back and edit. We observe in passing that a distinctive feature of Maple is that Maple does exact arithmetic with integers and fractions. It keeps fractions as the ratio of two integers. It will, however, automatically simplify such ratios to lowest terms:

\[ \frac{2}{3} \cdot \frac{6}{7} = \frac{18}{7} \]

\[ \frac{-2}{7} \]  

(2.21)

**Making typographical mistakes**

Making mistakes is a normal part of using any tool, be it a computer or otherwise. You'll probably make as many mistakes learning how to use Maple as you would make when learning a new sport, a musical instrument, or when learning how to write a good essay. Some of them will be obvious as soon as you make them, others will be subtle or harder to figure out how to fix.

When you make some kinds of mistakes, the computer may give you an *error message*. For example, if you make a typo and Maple doesn't recognize what you enter as being a valid command, it will complain. Here are some typical error messages. At this stage, some of the messages will make sense and you can react appropriately. Others will use vocabulary that is unfamiliar. For those, the best thing to do is to have a clear idea of what you want to enter (by closely imitating examples that are known to work) and checking carefully that what you have typed was accurate.
Some examples of Maple error messages

2 +
Error, invalid sum/difference

\[ 2 + \]

We intended to enter "2 + 4" but forgot to type the "4" before we hit enter (return). The appropriate thing to do here is to correct the expression and hit enter again.

\[ 2 + 4 \]

6

(2.22)

\[ + 2 4 \]

Error, missing operation

\[ + 2 . 4 \]

This time we mistakenly enter the expression with the symbols in the wrong order. Maple complains that it expects some operation to be entered between the two numbers but there isn't one.

\[ . + 4 \]

Error, invalid matrix/vector product

\[ . + 4 \]

We intended to enter "2+4" but typed a period instead of a 2 by mistake. Even though we are trying to do the same thing, the error message is different because a different symbol (the period) in this context suggests to Maple that we are trying to do linear algebra. The appropriate thing to do here is to correct the expression and hit enter again.

\[ 2 + 4 \]

6

(2.25)

\[ \frac{2}{0} \]

Error, numeric exception: division by zero

If we ask Maple to do an impossible operation, it sometimes gives an error (depending on the operation). The appropriate question to ask yourself here is "what should I be dividing by instead of zero?".

\[ \frac{3}{5 + 3 \cdot (} \]

Error, unable to match delimiters

\[ \frac{3}{5 + 3 \cdot 1 \cdot} \]

We started a sub-expression with a parentheses but forgot to finish it. In Maple, a delimiter refers to a parenthesis -- ( or ) -- a bracket [ or ], or a brace { or }. Delimiters are symbols that mark the beginning and end of an expression. In many instances they are necessary to unambiguously indicate meaning. For example \[ 5 \cdot (3 + 5) \] evaluates to 40, where as the expression without parentheses \[ 5 \cdot 3 + 5 \] means 20 because multiplications are always done before additions unless the parentheses indicate otherwise.
This is another instance of the same mistake. We wanted to enter \[
\left( 3 + \left( 5 + \frac{3}{7} \right) \cdot 5 \right) \cdot 2
\] but misplaced several parentheses.

We intended to enter "1+3" but typed the extra comma in by mistake. We get an error message that talks about sequences, a concept in Maple that we haven't discussed yet (that's coming in the next few chapters). Maple thinks that the sequence is "invalid" because it usually expects commas to be between items, such as "1,2,x". Maple's language has many other elements in it that we haven't gotten to discuss yet. If you use any of them by mistake then you will see messages with vocabulary we haven't discussed yet.

It's a fairly typical experience for new users to see some messages that you won't be able to gather much intelligence from other than the fact that you made a mistake that you should fix. With knowledge-rich systems such as Maple, you may blunder into sections of the system that you haven't learned yet. The best strategy is to back out of the situation by editing the expression so that it is exactly like something that is known to work.

This one is fairly obvious. In order to fix it though, we need to know what denominator we intended to enter.

**Correcting typographical mistakes**

The standard procedure for fixing a mistake is as you would in a word processor: *edit the mistaken input* and *re-execute the computation*. Here are ways of doing this:

Using the mouse, position the cursor where the mistake is. Then use the backspace key to erase the characters you want to get rid of. Type in more characters to replace it.

Use the left arrow key (←) to back up. Typing after backing up then inserts the new typing at the point where the cursor was positioned.

Use the mouse or other "pointing device" of your computer to select a section of what you typed. New typing then replaces the selection of what you typed.
Use the mouse to select a region, then "cut", which you can do through the Maple menu Edit -> Cut. Of course most people use the keyboard shortcut for cutting, which for Windows or Linux is control-X while on the Mac it's command-X.

Copying and pasting (control/command-C and control/command-V) also works in Maple.

You may find that sometimes you attempt to create a 2D Math input area but Maple does not compute a result for the input after you hit the enter key. To create a "clickable math" input area if this happens, place the cursor where you want the input area to be, and use the Format->Create Document Block Menu item of the Maple window:

Create Document Block to force a Math input area wherever the cursor is placed

Exponentiation (powers). Numbers with lots of digits

Use a caret ^ to specify an exponent (a "power"). In math mode, Maple will position the cursor so that the next things you enter will become the exponent. As with fractions, you can get out of the exponent by using the right arrow key → when you want to go back to non-exponent numbers. Try entering these expressions

\[ 2^3 = 8 \]
We note that Maple does integer and fraction operations exactly. It will not introduce any rounding error into a computation as a calculator would when the answer requires more than ten decimal digits to write down. There are limits to the number of digits Maple will use for integers or fractions, but they have to do more with ultimate limits of the computer hardware and memory rather than a "pre-ordained" decision about how many digits might be useful to keep. If you type \texttt{kernelopts(maxdigits)} into a Math input area on the worksheet, Maple will print out a number which is the maximum number of digits it can handle in any integer or fraction. On the author's computer,\texttt{kernelopts(maxdigits)} = 268435448. Note that this is not the value of the maximum number, but how many decimal digits the largest number can have.

For example, Maple can compute the result of

\[ \frac{1}{52!} + \frac{2^{100}}{3^{27}} \text{ exactly (try it!).} \]

Exact computation is useful not only for doing algebra but also for things such as computing probabilities through counting, or in deriving mathematical formulas for use in simulation or prediction programs.

\textbf{Detecting and fixing vocabulary and "logic" mistakes}

There will be other kinds of mistakes where there is no error message, but the response is not what you want. Sometimes this happens because you say something that while grammatical, means something entirely different from what you meant. This could be as simple as entering "2\cdot3" where you meant to type "2+3". Sometimes it is less obvious, such as mistyping the 23-rd digit of a 55 digit number or the 12th term of a long sum. Or worse yet, it could be because you are using the incorrect vocabulary so what you think you are saying does not have that meaning to the computer.

\textbf{Example of a vocabulary mistake}

\begin{align*}
2\cdot3 + 5 &= 2\cdot3 + 5 \\
2\cdot3 + 5 &= 11
\end{align*}

Suppose we were under the (mistaken) impression could use "\times" in Maple to stand for multiplication. We might use the above as a way to calculate "two times three, plus five". However, while there is no error message, what is calculated is not the number we were expecting. The first step towards proceeding to fix this is to realize that it's not what we want. To Maple, this is a legitimate calculation -- you want to create a formula that's "two times the variable x3, plus five".

Knowing that the proper way to enter multiplication is through a palette, or symbol "\ast" (asterisk) as explained in
Finally, there are mistakes made because you ask Maple to do the wrong calculation. Even though Maple does what you want, it turns out that what you wanted was wrong!

For example, you may read a word problem and decide to solve the equation \(3 \cdot x + 2 = 6\), whose solution is \(x = 4/3\). But when you plug the solution into the circumstances of the problem, you find that it doesn't solve the word problem. The problem may be because you used faulty logic to decide that \(3 \cdot x + 2 = 6\) was the equation, but it was actually \(2 \cdot x + 4 = 6\). This is known as an "error in logic" or just a "logic error".

Sometimes it's obvious that you made a mistake because the answer is obviously wrong. For example, seeing "+1" when you are expecting the answer to "2+3" is obvious because you know already that you shouldn't get an answer which is a negative number. Sometimes it isn't so obvious, so you need a way to check the correctness of the result.

2.4 Saving and retrieving your work

You can save your work in a Maple worksheet file through the File -> Save (keyboard shortcut: control/command-S) menu item of the Maple application. A dialog box appears allowing you to type in the name of the worksheet (we've typed in "test" into the box in the .)

The file is saved with a ".mw" suffix (e.g. test1.mw).

To retrieve the file in a subsequent Maple session, start up the Maple application as before and then use the File->Open menu item to initiate the dialog that retrieves the file.

Maple save menu operation
2.5 Retrieving backups

The "state of Maple" display appears on the bottom left hand side of the Maple window. Usually this display says "Ready", which means that Maple is awaiting your next command. Sometimes it reads "Evaluating..." which indicates that Maple is actively computing an answer. Sometimes it says "Autosaving worksheet", which means that it is saving a copy of the present state of your open worksheets into temporary storage on your computer. The amount of time Maple spends autosaving becomes noticeable in longer Maple sessions when the worksheet contains a lot of results.

Should your computer suddenly lose power or should Maple crash, you can retrieve the last autosaved worksheet by selecting the File -> Recent Documents -> Restore Backup menu item. This will fill your Maple with copies of all the autosaved worksheets. You may then delete them or save them to permanent file space as you wish.

The Maple state display
2.6 Algebra, plotting and mouse-clickable operations

Algebraic expressions and equations. Solving equations. Working with pieces of expressions.

We don't have to limit ourselves to just numerical calculation in Maple (even if the ability to use many digits and exact fractions allows us to do math more like the math books do). Another distinctive feature of Maple is that you can do algebra by entering expressions with symbols -- the \( x, y, z, i, \) and \( h \) that we see on algebra books. Maple will automatically collect terms and do some simplifications for us automatically

\[
x^2 + 2 \cdot x + 5 + 3 \cdot x
\]

\[
x^2 + 5x + 5
\]

We can even enter equations:

\[
\frac{3}{5} \cdot x + 1 = 4 - x
\]

\[
\frac{3}{5}x + 1 = 4 - x
\]

\[
3 \cdot x + 1 + 4 \cdot x = a \cdot x + b
\]

\[
7x + 1 = ax + b
\]

Note that while Maple automatically collected the \( x \) terms on the left hand side of the equation, it does not try to do the more interventionist operation of moving all the \( x \) terms to the same side of the equation.

Now, enter the following expression, but rather than hitting the enter key after you've entered it, do a right-click. On the Mac, instead of right-clicking hold the control key down then click on the mouse button (this is referred to as "control-click"). A menu of algebraic operations will pop up. Select "factor" and see how Maple can factor the polynomial:

\[
x^2 + 5 \cdot x - 50 \quad \text{factor} \quad (x + 10) \cdot (x - 5)
\]

Note that this line does not have a (XX) label for it. To further demonstrate the right-click (control-click) operations available, enter the following equation. Right click on the expression and a pop-up menu should appear that includes a "solve" item. Select the solve and a submenu will appear where you can specify that you want to solve for \( x \).

\[
\frac{3}{5} \cdot x + 1 = 4 - x \quad \text{solve for } x \quad \left[\left[ x = \frac{15}{8} \right]\right]
\]

For the previously experienced: some things are different, for a reason

(This section is for people who already know a programming language and are noticing that Maple does some things differently. Other readers can skip this section.) Most mainstream programming languages work in a similar way. That is why learning Maple has value beyond just being able to use the Maple system -- once you learn Maple, learning Matlab or Java or C is a matter of incremental adjustment. Noticing the differences is educational in that it makes you become aware of the arbitrariness of some of features of languages. If you have used another programming language...
such as Java or Visual Basic, you will notice that some things do not work the same in Maple as they do there. Some of this can be explained if you know something about the history of programming languages. Some of it is explained by being aware that the designers of Maple had different goals than those who invented Java or VB.

One thing that you have undoubtedly noted is that symbols do not have to have a value associated with them. For example, in Java if you said k=5; Then if you were to create another expression in Java such as System.out.println(k^2 + k + k + 3); then "5" would be used as the value of k in the expression and you would end up printing 38. In Maple, you do not have to associate k with a numerical value before you use k in an algebraic expression. If there is no prior association, Maple just treats the expression as a formula with symbols in it. It may do some algebraic simplification on what you entered, but it does not need to get a number as a result. Since there was no prior assignment for the expressions in section 2.5.1, the calculation done with them just keeps the formula..

Another thing that is different is that in Maple "=" is used for equations, not assignment. The operator in Maple corresponding to "=" in Java or VB is ":=" (a colon immediately followed by an equals, with no spaces inbetween). In Maple, if we wanted to associate "5" with the symbol k, then we would do:

\[
\begin{align*}
k := 5 \\
k^2 + k + 3 + k &= 38
\end{align*}
\]

People who know more than one programming language have a better understanding of which features are change a lot between languages, (such as whether = or := is used for assignment), and which ones are fairly uniform (+ being used for addition, or the use of parentheses in functions and expressions). Maple does not use "=" for assignment because, being a mathematically oriented language that can handle algebra, it wants to make the entry of equations a natural thing. Its use of "=" for assignment is a feature borrowed from the Algol/Algol 68/Pascal family of programming languages, which picked this operator to make it clear that this operation was not algebraic.

Is "=" better than ":="? That's a kind of question that is about as hard to answer as trying to decide whether "uno" is better than "one". If one had a language where you had to do ":=*&&%/#%^#++++" instead of "=" or ":=", you could be critical of the choice because it takes much more effort to enter a 35 character operator than a one or two character one. But Maple's choice of "=" has reasonable motivation -- "=" is used as a natural way to enter equations (which Java and VB do not support linguistically), and "=" suggests something similar while being distinctly different. Just as with architectural design of a building, each feature of a programming language is typically carefully considered. Many features are borrowed or copied from predecessor languages, where they have already been subjected to the test of many people using the feature. If you are not familiar with Algol family languages, you can see examples of them at various educational web sites, such as http://www.engin.umd.umich.edu/CIS/course.des/cis400/algol/average.html and http://portal.acm.org/citation.cfm?id=154766.155365).

**Plotting and approximate numerical solutions**

The right-clickable interface can also activate a plot of a formula you may have entered. Enter this formula, then right-click and select Plot ->2d plot. The automatic defaults for plotting this produce this result.
Example of plotting

If we click on the plot and then position the mouse over the plot area, we see in the upper left hand corner of the Maple application a pair of coordinates that change as we move the mouse around. We can "eyeball" the plot with this to find approximately where this formula is equal to zero. From the figure below we can see that \( x^2 - 10 \cdot x + 4 \) is zero at about .5 and 9. We could position the cursor in those areas to get a more precise (but still rough) estimate.

Plot created by right-click -> Plot -> 2DPlot.
The 2DPlot operation makes pre-set decisions about the plot, such as the range of \( x \) (-10 to 10), the color of the line, axes labelling, etc. Users can inject their own preferences about these things about this by selecting right-click -> Plot -> PlotBuilder and filling in the dialog box with their choices.

User-configured plot using PlotBuilder instead of 2DPlot

\[ x^2 - 10x + 4 \]

Plot build with right-click->Plots->PlotBuilder
The Expressions Palette and the Common Symbols Palette: entering Trigs, logs, roots, exponentials

It's possible to get the common functions of high school algebra, pre-calculus, and calculus by using the Expression palette of the Maple Window:

For example, to enter the square root of 36, click on the palette entry for $\sqrt{a}$. That expression will appear in the document, with the "a" selected. If you then type 36 on the keyboard, that number will replace the selected text. If you then hit the enter key, Maple will evaluate the expression and produce the exact result "6".

\[
x + y + \frac{1}{2} + \frac{1}{4} + \sqrt{36}
\]

\[
x + y + \frac{27}{4}
\]

(2.39)

You can use the palette multiple times, to create more complicated expressions. Just continue to the use mouse or the arrow keys to move around in the expression. Selecting and typing, backspacing or deleting are all ways of replacing or correcting pieces of the expression. The Common symbols palette, two panels below the Expression palette, can be used to enter $\pi$ and $e$, the base of the natural logarithm system. The palette does not have the inverse trig functions, so you have to enter them through typing. Their names are: arcsin, arccos, arctan, etc.
Examples of palette-driven computation

\[
\sin\left(\frac{\pi}{4}\right) + \cos\left(\frac{\pi}{4}\right) = \sqrt{2}
\]

\[
\left(\sqrt{1024} + \ln\left(\frac{\pi}{3}\right)\right) \cdot \pi = \frac{98}{39} \pi
\]

\[
\arcsin\left(\sin\left(\frac{1}{4} \pi\right)\right) = \frac{1}{4} \pi
\]

Approximate numerical (calculator - type) arithmetic in Maple

If you enter expressions with integers, exact fractions, and symbols such as \(\pi\) and \(e\), then Maple will perform exact calculations rather than give approximate answers as a conventional calculator would. You can get approximations by selecting the "numerically solve" instead of the "solve" option from the right-click pop-up menu.

Examples of computing with approximate solving

\[
\begin{align*}
\quad x^2 - 10x + 4 = x^2 - 10x + 4 & \quad \rightarrow \quad \text{solve} \\
\quad \text{solve: } \{x = 5 + \sqrt{21}, x = 5 - \sqrt{21}\} & \{x = 5 \}
\end{align*}
\]

Exact solution of an equation using the "solve" feature of the pop-up menu.

\[
\begin{align*}
\quad x^2 - 10x + 4 & \quad \rightarrow \quad \text{solve} \\
\quad \text{solve: } 0.4174243050, 9.582575695
\end{align*}
\]

Using the "numerically solve" feature of the pop-up menu.

If you have an exact expression, you can ask Maple to approximate it to 5, 10, 20, or more digits. In this mode, Maple can be used as a super-accurate calculator.

Examples of numerical computation

1. Enter fraction, select approximate->20 from right-click pop-up menu.

\[
\frac{47}{52} + \frac{4}{3} \quad \rightarrow \quad 2.2371794871794871795
\]

2. Enter exact expression, select approximate->5 from right click pop-up menu.

\[
\sin\left(\frac{\pi}{10}\right) \quad \rightarrow \quad \text{at 5 digits} \quad 0.30902
\]

3. Enter equation. Then solve->solve, then select Element->1, then right hand side, then approximate->10
Evaluation at a point, and selection of pieces

Sometimes you wish to evaluate an expression for a particular value of a variable. There is a right-click operation that does this.

**Evaluate at a point**

<table>
<thead>
<tr>
<th>Expression</th>
<th>Operation</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x^2 - 2\cdot a\cdot x = 0$</td>
<td>evaluate at point</td>
<td>$\frac{1}{4} - a = 0$</td>
</tr>
<tr>
<td>$x^2 - 2\cdot a\cdot x = 0$</td>
<td>evaluate at point</td>
<td>$x^2 - 6y^2 x = 0$</td>
</tr>
<tr>
<td>$3\cdot y + 5$</td>
<td>evaluate at point</td>
<td>14</td>
</tr>
</tbody>
</table>

Expressions often have pieces. Using the right-click menu, it's possible to select or extract a portion of an expression for further work.

**Operations on equations**

<table>
<thead>
<tr>
<th>Expression</th>
<th>Operation</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x = \frac{\sin(a)}{r^2 - 1}$</td>
<td>right hand side</td>
<td>$\sin(a) = \frac{r^2 - 1}{r}$</td>
</tr>
<tr>
<td>$x = \frac{\sin(a)}{r^2 - 1}$</td>
<td>left hand side</td>
<td>$x$</td>
</tr>
</tbody>
</table>

One of the options in the right-click menu is "right hand side". It only works for equations.

**Operations on multipart expressions**

<table>
<thead>
<tr>
<th>Expression</th>
<th>Operation</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x^2 - 4\cdot x = 4$</td>
<td>solve for x</td>
<td>$x = 2 + 2\sqrt{2}, x = 2 - 2\sqrt{2}$</td>
</tr>
<tr>
<td>$x = 2 + 2\sqrt{2}$</td>
<td>select entry 1</td>
<td>$x = 2 + 2\sqrt{2}$</td>
</tr>
<tr>
<td>$x = 2 + 2\sqrt{2}$</td>
<td>select entry 1</td>
<td>$x = 4.8284$</td>
</tr>
</tbody>
</table>

Solving this quadratic equation reveals that there are two solutions. Right clicking on these selections and then select entry -> 1 produces the first solution. We can then approximate it by using the
## 2.7 A quick-reference summary to this chapter

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arithmetic</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$2 + \frac{3^2}{4} - \frac{1}{6}$</td>
<td>Use $+$, $<em>$, $-$, $/$, $^</em>$ for arithmetic. Hitting the Enter key produces a labelled result. Maple’s simplification automatically combined fractions and places things in lowest terms.</td>
<td></td>
</tr>
<tr>
<td>$5!$</td>
<td>Use $!$ for factorial</td>
<td>Do you know what $5!!$ (double factorial) means?</td>
</tr>
<tr>
<td><strong>Making mistakes</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$2 + \left( \frac{3}{5} \right)$</td>
<td>Error message mistakes (from typos or mistakes in intensions)</td>
<td>The easiest ones to detect. You have to figure out what you are doing wrong, though. The error message may not always be helpful in advising you on this, although it often is.</td>
</tr>
<tr>
<td>A farmer plants a fence post every foot, for 1250 feet. At that point, he switches to planting the fence posts every 4.7 feet for another 940 feet. How many fence posts does he need in all?</td>
<td>“Logic errors”</td>
<td>You are asking Maple to compute something that it understands, so it gives you an answer. However, this answer doesn’t really solve your problem. You need to find a more appropriate computation, which you can only do by thinking about whether you went wrong. Often you can find these kinds of mistakes by looking at simpler versions of the problem where the answer can be figured out with paper and pencil. Then you can &quot;scale up&quot; the answer to handle the actual problem you have. The correct answer is $1251 + 201 \times 1452$ fence posts. The computer did what it was asked to do -- the problem was that it was asked to do the wrong thing.</td>
</tr>
<tr>
<td>$\frac{1250}{1} + \frac{940}{4.7}$</td>
<td>Maple did do the arithmetic in the above calculation correctly. The problem is that it’s the wrong calculation. Do you see how to get the right answer?</td>
<td></td>
</tr>
<tr>
<td><strong>Editing (fixing mistakes)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>backspace, delete erase starting from current cursor selection</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Arrow keys→← move cursor within current selection</td>
<td></td>
</tr>
</tbody>
</table>
Select with mouse/type replaces selected text

Cut, copy and paste of a selection works as it does with a text processor

File saves, opens

Save files with File -> Save or File -> Save As. Open a saved file with File -> Open. Other File operations similar to that of standard word processors.

Functions

Insert math into an expression by using the Expression and Common Symbols Palette.

If you are entering a function by the keyboard rather than the palette, you must enclose the function's argument in parentheses.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\sqrt[n]{1 + e}$</td>
<td>Square roots, $n$-th roots</td>
</tr>
<tr>
<td>$\ln\left(e^2 - e^{\frac{5}{2}}\right)$</td>
<td>natural logarithms (base $e$)</td>
</tr>
<tr>
<td>$\text{arcsin}, \text{arccos}, \text{arctan}$</td>
<td>Trig functions: sin, cos (trig functions all use radians, not degrees)</td>
</tr>
<tr>
<td>$\text{sec}, \text{csc}$</td>
<td>Base 10 logarithms</td>
</tr>
<tr>
<td>$\pi, \Sigma$</td>
<td>summation</td>
</tr>
</tbody>
</table>

Algebra

Right-click (control-click on Mac) on an entered expression to get the pop-up menu.

Chapter 2 demonstrated examples of the following operations:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>factor</td>
<td>factor</td>
</tr>
<tr>
<td>solve</td>
<td>solve numerically</td>
</tr>
<tr>
<td>right hand side (of an equation)</td>
<td>select (n-th part) of an expression</td>
</tr>
<tr>
<td>left hand side (of an equation)</td>
<td>plot (two-dimensional) -- many plot options to determine range and domain of plot, color, captions, etc.</td>
</tr>
<tr>
<td>approximate numerically (to 5, 10, 20, etc. digits' accuracy)</td>
<td>evaluate at a point (choose values for variables in an expression)</td>
</tr>
</tbody>
</table>

Plotting
The expression must be something that involves a single variable and will result in a number when a value is used for that variable. Thus you can’t do a 2d plot of $x^2 - a$ because you wouldn’t get a number if you picked a value just for $x$ (or just for $a$)

Maple uses defaults for the plot range, and the plot color.

Trying to plot an equation produces an implicit plot (see next appendix).

A dialog box appears that allows you the select from many more options, such as plot color, the line style, vertical and horizontal ranges, captions, etc.

Limited precision (decimal point) numbers

$\cos(x^2) - \sqrt{x}$ \hspace{1cm} solve $\rightarrow 0.7352027350$

$0.1 + \frac{2}{3} + \tan(1) + \pi^2$

$0.7666666667 + \tan(1) + \pi^2$

right-click $\rightarrow$ approximate $\rightarrow$ n takes an exact numerical expression and approximates it.

Exact numbers in Maple have no decimal points. Numbers with decimal points in Maple cause arithmetic calculations to be done approximately.

solve $\rightarrow$ numerically solve produces approximate solutions

Use of limited precision numbers in algebra (e.g. factoring, differentiation, solving) may not produce good results.

Use them in Maple only when an approximate result is desired.

Numbers like .25 or .6015 are limited precision. If you want exact algebra done, use 1/4 or 6015/10000, etc.

In very large calculations, limited precision calculations may be noticeably faster than those with exact arithmetic. Most of the time there isn’t an appreciated difference.
This operation will give a pop-up menu that will allow us to choose values for all the variables. In the first example, we picked 1/2 for a value of x. Note that the pop-up menu will show what you typed rather than displaying 2D math. In the second example, we specified "3*y^2" as the value for a. In the third example, we picked 3 as the value for y.

<table>
<thead>
<tr>
<th>Example</th>
<th>right hand side, left hand side</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x = \frac{\sin(a)}{r^2 - 1}$</td>
<td>right hand side $\sin(a)$</td>
</tr>
<tr>
<td>$x = \frac{\sin(a)}{r^2 - 1}$</td>
<td>left hand side $x$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operations on multi-part expressions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>select entry</td>
<td>$x^2 - 4 \cdot x - 4$ solve for x</td>
</tr>
<tr>
<td>solve for x</td>
<td>$\begin{cases} x = 2 \ + 2 \sqrt{2} \ - 2 \sqrt{2} \end{cases}$</td>
</tr>
<tr>
<td>select entry 1</td>
<td>$x = 2 + 2 \sqrt{2}$</td>
</tr>
<tr>
<td>select entry 1</td>
<td>$x = 2$</td>
</tr>
<tr>
<td>at 5 digits</td>
<td>$x = 4.8284$</td>
</tr>
</tbody>
</table>

Solving this quadratic equation reveals that there are two solutions. Right clicking on these selections and then select entry -> 1 produces the first solution. We can then approximate it by using the

Enter an expression in a document, then right-click (control-click on Mac) followed by:

<table>
<thead>
<tr>
<th>Operations on symbolic expressions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>solve-&gt;solve</td>
<td>$x^2 - 1 \rightarrow (x = 1), (x = -1)$</td>
</tr>
<tr>
<td>solve-&gt;solve for a variable</td>
<td>$x^2 - 2 \cdot a \cdot x = 0 \rightarrow \begin{cases} x = 0 \ [x = 2 \cdot a] \end{cases}$</td>
</tr>
<tr>
<td>solve-&gt;numerically solve</td>
<td>$x = \cos(x) \rightarrow 0.7390851332$</td>
</tr>
</tbody>
</table>

The thing to try when there is a numerical answer but the exact solution is too complicated to understand or Maple can't find an exact solution.
### Factoring

\[ x^2 - 1 = \text{factor} \quad (x - 1)(x + 1) \]

\[ \cos(x)^2 - \sin(x)^2 = \text{factor} \quad (\cos(x) - \sin(x)) (\cos(x) + \sin(x)) \]

Factoring can simplify an expression sometimes. Factoring doesn't know the trig simplification rules, though.

### Plots->2d plot

\[ x^2 - 1 \rightarrow \]

The expression must be something that involves a single variable and will result in a number when a value is used for that variable. Thus you can't do a 2d plot of \( x^2 - a \) because you wouldn't get a number if you picked a value just for \( x \) (or just for \( a \)). Maple uses defaults for the plot range, and the plot color.

### Plots->plot builder -> 2d plot

\[ x^2 - 1 \rightarrow \]

A dialog box appears that allows you the select from many more options, such as plot color, the line style, vertical and horizontal ranges, captions, etc.

### Operations on equations

**Example**

<table>
<thead>
<tr>
<th>right hand side, left hand side</th>
<th>[ x = \frac{\sin(a)}{r^2 - 1} ]</th>
<th>[ \frac{\sin(a)}{r^2 - 1} ]</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ x = \frac{\sin(a)}{r^2 - 1} ]</td>
<td>left hand side: [ \frac{\sin(a)}{r^2 - 1} ]</td>
<td>right hand side: [ \frac{\sin(a)}{r^2 - 1} ]</td>
</tr>
</tbody>
</table>
### Operations on constant expressions

<table>
<thead>
<tr>
<th>move to right, move to left</th>
<th>$x^2 + x + 1 = a$ move to right</th>
<th>$0 = a - x^2 - x - 1$</th>
<th>This moves the entire side of an equation to the other side.</th>
</tr>
</thead>
</table>

#### Example

<table>
<thead>
<tr>
<th>approximate-&gt;5 (or 10, 20, 50)</th>
<th>$\tan \left( \frac{\pi}{10} \right) \sqrt{10} \quad \text{at } 20 \text{ digits} \quad 0.34157868529293212152$</th>
<th>Uses approximation methods to turn constants into an approximate (decimal point) number with 5 (10, 20, 50) digits.</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x = \ln(5000!)$ at 20 digits</td>
<td>$x = 37591.143508876766569$</td>
<td></td>
</tr>
</tbody>
</table>
3 Chapter 3 Exact and limited-precision (floating point) numbers

3.1 Chapter Overview

In Maple, there are two types of numbers, \textit{exact numbers} (printed as whole numbers, and fractions), and \textit{limited-precision numbers} (written as a number with a limited number of digits after a mandatory decimal point).

The arithmetic Maple does with exact numbers is completely accurate.

The arithmetic Maple does with limited-precision numbers (like that of calculators or other standard computer languages) gets rounded at each stage to the number of digits being used. If the correct answer requires more digits than that, then some inaccuracy occurs.

The differences between exact and limited-precision numerical arithmetic leads us to the following rules:

\begin{itemize}
\item[a)] Exact arithmetic is necessary if you are doing analytical work, such as a theoretical calculation or calculus homework.
\item[b)] Limited-precision arithmetic is faster but sometimes less accurate. It's good for situations where the numbers you're working with come from limited-precision measurements, and when you know you aren't going to get into trouble from the rounding errors made by keeping things in limited precision.
\end{itemize}

3.2 Exact arithmetic with exact numbers

There are three types of exact numbers in Maple, integers, fractions, and symbolic constants. If you enter an arithmetic expression with such numbers, Maple will do all the arithmetic exactly. It will also automatically evaluate functions that have simple exact results, such as

\[
\sin \left( \frac{\pi}{6} \right) = \frac{1}{2}.
\]

Some exact numbers

<table>
<thead>
<tr>
<th>Type</th>
<th>Examples</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integers (whole numbers)</td>
<td>2, 5, -1005</td>
<td>In Maple, integers can be up to hundreds of thousands of digits long.</td>
</tr>
<tr>
<td>Fractions (ratios of integers)</td>
<td>$\frac{3}{5}$, $\frac{9}{7}$, $\frac{-14597}{111111111}$, $\frac{1}{1111111111}$</td>
<td>In Maple, the numerator and denominator can be up to hundreds of thousands of digits long.</td>
</tr>
</tbody>
</table>
You can enter \( \pi \) from the Common Symbols Palette, or you type the letters Pi from the keyboard to get the same thing. The first letter must be capitalized.

You can enter \( e \) from the Common Symbols Palette, or you can type the letters \( \exp(1) \) from the keyboard. Typing \( e \) from the keyboard does not work -- it means the algebraic unknown \( "e" \) (as in \( "x", \"y\", \) etc.), not a constant.

You can enter \( \sqrt{2} \) from the Expression Palette, or you can type the letters \( \text{sqrt}(2) \) from the keyboard.

While entering \( \sin(0) \) using the Expression Palette would return a result of 0, entering \( \sin(60) \) results in the same thing. There is no simpler way of expression this constant. Maple always uses radians for trig functions so this is not talking about the sine of 60 degrees, but rather the sine of 60 radians.

You can enter \( \infty \) from the Common Symbols palette, or infinity by typing on the keyboard.

Maple uses "capital I" as the symbolic constant the square root of -1. Select \( i \) from the Common Symbols palette, or type shift-i from the keyboard. Lower case \( i \) (without the shift key) is not a symbolic constant.

### Exact arithmetic is always exact

\[
3 + \frac{4}{7} + \frac{9}{11} + \frac{13}{15} = \frac{6236}{1155}
\]

Maple takes fractions and integers and produces the integer or fraction that results. It will automatically divide out the common divisor of numerators and denominators.

The way we entered the example was to enter the expression \( 3 + \frac{4}{7} + \frac{9}{11} + \frac{13}{15} \) into a document box, and then type control-= (control key and equals key at the same time.)

\[
= \frac{-1}{10}
\]

\[
= \frac{10}{3}
\]

\[
\tan\left(\frac{301}{281} \pi \right) + \frac{\tan(870\pi)}{10 \ln(e)} = \frac{3.1416}{2.7183}
\]

Maple does symbolic arithmetic to get \( \tan(580\pi) \) which it can simplify to 0.

This is a demonstration that "Pi" and "pi" do not have the same meaning in Maple even if they look similar. It also shows that the \( e \) you get from typing does not have the same meaning as the \( e \) you get from the palette.

You can right-click on Pi or the \( e \) you get from the palette and have a numerical approximation produced. pi or e typed from the keyboard does not even have numerical approximation as an option, because they are regarded as symbols like \( x \) or \( y \) that stand for algebraic unknowns, not symbolic constants.

\[
\frac{\sqrt{35}}{6} = \frac{8575}{3}
\]

We did this by entering \( \sqrt{35} \) into a document box, and then typing control-=.
3.3 Limited-precision (calculator-style) arithmetic with limited-precision numbers.

If you see a number on your Maple document with a decimal point, it's a limited precision number or floating point number. If you see a number without a decimal point, it’s an exact number. Maple performs calculator-style arithmetic (called limited-precision arithmetic or floating point arithmetic) when it sees this number.

By default, Maple creates limited precision numbers with ten decimal digits' accuracy. However, if you enter a number with a decimal point that has more digits than that, it will create it with as many digits as you use. Limited precision numbers can be written in scientific notation using an "e" to indicate the exponent. You can't use "e" syntax to enter an exact number.

Limited-precision numbers are sometimes called floating point numbers.

**Limited-precision (floating point) numbers**

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.1</td>
<td>Note that this is not the same as the exact number zero (0)... it has a decimal point after it.</td>
</tr>
<tr>
<td>0.00</td>
<td>If you enter a number that needs more than ten decimals, Maple will use them all.</td>
</tr>
<tr>
<td>0.12345678901234567890</td>
<td>At some point, Maple will display a large or small number using powers of ten rather a lot of leading-zero decimal places.</td>
</tr>
<tr>
<td>0.0001367890</td>
<td>You can type in a number with a power of ten using the &quot;e&quot; notation. Here &quot;e&quot; is the symbol typed from the keyboard, not the from the Common Symbols keyboard.</td>
</tr>
<tr>
<td>-0.0001367890</td>
<td>You can also use the capital E typed from the keyboard.</td>
</tr>
<tr>
<td>-0.00000000000001367890</td>
<td></td>
</tr>
<tr>
<td>-1.367890 \times 10^{-13}</td>
<td></td>
</tr>
<tr>
<td>1.69e35</td>
<td></td>
</tr>
<tr>
<td>1.69 \times 10^{35}</td>
<td></td>
</tr>
<tr>
<td>0.00169E-22</td>
<td></td>
</tr>
<tr>
<td>1.69 \times 10^{-25}</td>
<td></td>
</tr>
</tbody>
</table>

Calculator-style arithmetic differs from exact arithmetic in that the computer uses only a fixed number of decimal places (by default, ten). If more than that is needed to write down the answer, the computer will round the result back to the fixed precision (number of decimal places) being used. This may result in relatively small error. However we shall see situations where the rounding error can contaminate the accuracy of the result, to the point where it can't be believed.
Limited-precision (floating point) arithmetic

<table>
<thead>
<tr>
<th>Expression</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 + .1 + .02 + .9e−9 + .8e−12</td>
<td>1.120000001</td>
</tr>
<tr>
<td>1 + .1 + .02 + .9e−9 + .8e−12 (-1 - .1)</td>
<td>0.020000001</td>
</tr>
<tr>
<td>1 + .1 + .02 -.1 -1 + .9e−9 (+ .8e−12)</td>
<td>0.0200000090</td>
</tr>
</tbody>
</table>

We see that the result has rounded away some of the smaller terms.

We've subtracted away 1.1, but only after the rounding has occurred for the intermediate steps of the computation. So we've lost the smaller digits.

We get a more accurate result if we add the numbers together in a different order. This means limited-precision arithmetic does not obey the law of commutivity of addition.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0 (\div) 3.0</td>
<td>0.333333333</td>
</tr>
<tr>
<td>1.0 (-) 1.0 (\div) 3.0</td>
<td>1.10(^{-10})</td>
</tr>
<tr>
<td>1 (-) (\frac{1}{3}) (\cdot) 3</td>
<td>0</td>
</tr>
</tbody>
</table>

Because of rounding, the result of dividing one by three is not exactly one-third.

Maple's exact result is exactly correct.

By using a floating point number, Maple computes an approximation to \(\sin(\pi)\). It's not quite the same as the exact result.

\[
\sin(3.1415926535) = -4.102067615 \times 10^{-10}
\]

\[
\sin(\pi) = 0
\]
3.4  Maple will decide what kind of arithmetic to use by how numbers look

First note that any "calculator number" can be written as a fraction. For example, 1.98376 can be written (somewhat less conveniently) as 198376/10000. Therefore, if we want to talk about any (real) number, we can use an integer, fraction, or symbolic constant. Like most computer programming languages, Maple processes only what it sees written. It can't read your mind that you really meant Pi when you entered 3.1415, or that you meant 1/3 when you wrote .3333333333. Maple follows this rule:

if you write a number with a decimal point in it, Maple treats it as a limited-precision number and does limited-precision arithmetic with it

if you write a number without a decimal point in it, Maple treats it as exact and does exact arithmetic with it. It will also perform algebraic simplifications exactly, such as

\[
\sin\left(\frac{\text{Pi}}{6}\right) = \frac{1}{2}\]

If you mix two both kinds of numbers, Maple will eventually start using floating point arithmetic when it encounters the floating point numbers.
3.5 Differences between limited-precision numbers in Maple and in math text books

There are some subtle differences between "the mathematical world", "the math student world", and "the Maple world" in how numerical notation works.

Math textbooks and students use ".1" and "1/10" interchangeably. Maple regards them as completely different. Because of the "contagion" of limited-precision arithmetic, if you want an all exact calculation (because the problem requires you to express the answer using fractions, for example), then you cannot use .1 in the expression you enter into Maple.

Students sometimes use numerical approximations as being the same number as what they approximate. For example, some people start believing that "3.14" or "3.14159265" is the same as π, or that .3333333333 means the same thing as \( \frac{1}{3} \). Maple knows better. You'll get wrong answers if you try to push calculator expectations into a computer environment where the computer follows the rules of algebra, as illustrated by the example ???.

Factoring works for polynomials with exact coefficients, but not necessarily for polynomials using approximations for the fractions. It would probably work better if we were using numbers like ".25" or ".6061" which require fewer than ten digits to write down with complete accuracy.

Two expressions factored

<table>
<thead>
<tr>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>( x^2 - \frac{10}{3}x + \frac{49}{16} - \frac{41}{144} ) factor = ( \frac{1}{9} (3x - 5)^2 )</td>
<td>Maple can factor polynomials with exact coefficients, if there is a way of factoring them with integer or rational numbers.</td>
</tr>
<tr>
<td>( x^2 - 3.333333333x + 2.777777778 ) factor = ( x^2 - 3.333333332x + 2.777777777 )</td>
<td>Maple's factor operation can't find factors for polynomials that only approximate the exact coefficients.</td>
</tr>
</tbody>
</table>

Numerical solving doesn't necessarily produce the same results when approximations are used for a polynomial's coefficients. Here the use of decimal point approximations for the coefficients, even though they are about as precise as ten digits can handle, produce complex number roots rather than real roots! They are "close", but they are they qualitatively different.

Two equations with "numerical solve"

<table>
<thead>
<tr>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>( x^2 - \frac{10}{3}x + \frac{49}{16} - \frac{41}{144} = 0 ) solve for ( x ) ( x = \frac{5}{3}, x = \frac{5}{3} )</td>
<td>When we right-click-&gt;solve for variable ( x ), we see that the equation has a double root.</td>
</tr>
<tr>
<td>( x^2 - \frac{10}{3}x + \frac{49}{16} - \frac{41}{144} = 0 ) solve ( 1.666666667, 1.666666667 )</td>
<td>When we right-click-&gt;solve-&gt;numerically solve, we see approximations to the two roots. Some amount of exact arithmetic is tried initially to see if there are exact values to be found. Then these values are numerically approximated.</td>
</tr>
</tbody>
</table>
When we approximate the coefficients with floating point numbers, and then solve, all the solving is done with floating point numbers. We see that the solver (which is trying as best as it can given that it can only work with limited precision), instead of a double root, it finds two complex number roots -- "I" is Maple's symbol for the square root of -1. This is an example where wholesale use of floating point arithmetic produces results that fall surprisingly short of the mathematical truth.

Use of limited-precision numbers can produce results that differ in surprising ways from the way we think of numbers behaving. For example, if you add four floating point numbers in two different orders, you may get different results!
### Contrasting approximate and exact arithmetic

<table>
<thead>
<tr>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
</table>
| \[
\frac{1}{1000} + 200000000000 + 1 \\ - 20000000000 - 1
\] | We add together four numbers. We get a result. |

| 20000000000 + 1 \\ - 20000000000 \[\frac{1}{1000}\] | We add together the four numbers in a different order. We get the same result because "addition is commutative". |

| 1.0e-3 + 2e11 + 1.0 -2e11 - 1.0 | We do this with limited precision numbers. We don't get anywhere near the same answer. In fact, we get almost as many answers as ways we have of writing the expression. This would probably be true of your pocket calculator, if it kept only 10 digits of precision. You could manufacture an example that would show something similar happening no matter how many digits your calculator kept. |

| 2e11 + 1.0 - 2e11 - 1.0 + 1.0e-3 | The bottom line: with limited-precision numbers, evidently \[a + b + c = a + c + b\] is not always true. What other kinds of mathematical laws does your calculator disobey? If this does not make you nervous, then you'd probably be fine with an engineer who designed a supersonic airplane using "not exactly" the laws of airflow or built a chemical refinery using "not exactly" the laws of chemistry! |

This gives us a few rules of thumb for using numbers with decimal points in them. a) If you are doing algebra (e.g. "deriving a formula"), don't use .1, .75, or .206, use 1/10, 3/4, or 206/1000. instead. b) If the problem you are working needs only approximate answers (e.g. "using a formula"), then enter a formula with all-exact numbers, do any algebra necessary, and then switch to numerical solving or approximations. c) Only if you are sure that you can perform all the steps with numerical arithmetic and get an answer accurate enough for your purposes should you start off in numerical mode. If you need to do algebra, you should stick with exact numbers until you want to stop doing algebra and just do calculation.

In some technical systems, such as Matlab or Python, the primary kind of numbers are integers (up to a fixed size, such as 9 digits), and limited-precision (usually with 16 digits accuracy maximum). Exact numbers are either completely
unavailable, or they are available only through means that require much more extra work (more typing, usually). Maple is one of the few systems where both kinds of numbers exist together.

We observe that when some technical people use limited-precision numbers, they usually skip the accuracy testing and just hope that the limited precision isn't going to bite them since much of the time the computed results are reasonably accurate. Unfortunately this is not always the case, especially when it comes to situations involving large amounts of money. See for example http://books.google.com/books?id=NDbQe52pX3kC&pg=PA38&lpg=PA38&dq=Vancouver+stock+exchange+roundoff+error&source=web&ots=vkseL01hBP&sig=FBXWmcpsAqg4f37Zz7cvQOmlZM&hl=en&sa=X&oi=book_result&resnum=2&ct=result#PPA38,M1 or page 183 of http://www.validlab.com/goldberg/paper.pdf. The person doing the calculations is always responsible for their appropriate use. If you are in a high-stakes situation with your professional or academic reputation on the line, the only responsible path is to check your limited-precision work for its (in)-accuracy.

3.6 Which kind of numbers and arithmetic should I use?

Exact arithmetic makes it easy to do formula manipulation (algebra) with the computer correctly, but limited precision arithmetic is often faster. So,

**Guidelines for using exact and limited-precision numbers in Maple**

1. If you're doing a calculation for mathematical or theoretical analysis and are given exact values for the parameters of the problem, use integers, fractions, and symbolic constants in your expressions. If get a number at the end of the analysis, and you want "ballpark" estimates of the magnitudes, you can always approximate these exact numbers at the end of the computation. IN THIS SITUATION AVOID USING NUMBERS WITH DECIMAL POINTS -- use 1/2 instead of .5, 1/10 instead of .1, Pi instead of 3.1415.

2. If you're doing a non-analytical computation (e.g. a computation where all the numbers are taken from measurements, not from theory) then it's probably okay to use numbers with decimal points. As we have seen, even if you mix exact and limited-precision numbers, most of the calculation will probably be done in limited precision.

3.7 Summary of Chapter 3 material

<table>
<thead>
<tr>
<th>Examples of floating point (limited precision) numbers</th>
<th>They all have a decimal point or an eXX in them.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0, 2.5e-3, 3.230e-1, -999667.3e2, 9876e53</td>
<td>1.0, 0.0025, 2.30, -9.996673 10^7, 9.876 10^56</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Examples of exact numbers -- integers and rational numbers (fractions)</th>
</tr>
</thead>
<tbody>
<tr>
<td>111222, 11/33</td>
</tr>
<tr>
<td>111222, 1/3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Examples of exact numbers -- symbolic constants</th>
</tr>
</thead>
<tbody>
<tr>
<td>π, e, i, ∞</td>
</tr>
<tr>
<td>π, e, i, ∞</td>
</tr>
</tbody>
</table>

**Differences between math world and Maple world**
1/10 is an exact number, .1 is a floating point number. The most important difference between them is that an arithmetic expression with all exact numbers will use exact arithmetic, whereas an expression with all floating point numbers will use limited precision arithmetic, which is different.

Exact identities don't apply necessarily to floating point numbers. For example:

\[
\sin\left(\frac{\pi}{3}\right), \sin\left(\frac{\pi}{3.0}\right)
\]

\[
\frac{1}{2} \sqrt{3}, \sin(0.3333333333 \pi)
\]

Operations on all numbers obey basic laws such as commutativity of addition. Operations on exact numbers obey basic laws such as commutativity of addition. Arithmetic on floating point (limited precision) numbers do not obey the commutative law of addition. (This is true not only for Maple but for calculators and for the arithmetic hardware of most computers.)

### Why there are two kinds of numbers in Maple

<table>
<thead>
<tr>
<th>Math world</th>
<th>Maple world</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\frac{1}{10}$ and .1 mean the same thing</td>
<td>1/10 is an exact number, .1 is a floating point number. The most important difference between them is that an arithmetic expression with all exact numbers will use exact arithmetic, whereas an expression with all floating point numbers will use limited precision arithmetic, which is different.</td>
</tr>
<tr>
<td>sin(π/3) and sin(π/3.0) mean the same thing</td>
<td>Exact identities don't apply necessarily to floating point numbers. For example:</td>
</tr>
<tr>
<td>factoring and other algebraic operations work on any expression</td>
<td>algebraic operations are only guaranteed to work well on expressions with all exact numbers.</td>
</tr>
<tr>
<td>Operations on all numbers obey basic laws such as commutativity of addition</td>
<td>Operations on exact numbers obey basic laws such as commutativity of addition. Arithmetic on floating point (limited precision) numbers do not obey the commutative law of addition. (This is true not only for Maple but for calculators and for the arithmetic hardware of most computers.)</td>
</tr>
<tr>
<td>Exact arithmetic is completely accurate, but somewhat slower than 10 digit floating point arithmetic.</td>
<td>10 digit floating point arithmetic can be faster compared to doing calculations with very large fractions or integers, but is not completely accurate</td>
</tr>
</tbody>
</table>
4  Chapter 4 Words, labels, assignments, and scripts

4.1  Chapter Overview

We learn how to use Maple as a word processor. This allows us to "write up" computations with explanation being provided along the way.

We learn how to use the labels that Maple uses for each expression that we enter into a worksheet by hitting the enter (on some computers, return) key. They can be useful to retrieve computed values in subsequent steps of a multi-step computation.

We learn how to use the assignment operation := to label results with symbolic names. Like labels, these names can be used in subsequent steps of a computation. Assignment is a fundamental feature of used in writing computer programs.

4.2 Maple as a word processor

Maple documents allow a mixture of text and mathematics. Here's a short description: 1. Position the cursor at the spot where you want to enter text.

2. Type control-T (on Macintosh, command-T). Alternatively, you can use the Maple menu Insert->Text. The Toolbar will show that you are text mode.

3. With the keyboard, enter your verbiage. When you are in text mode, you will also see that the menu bar will be enabled for boldface, italics, underlining, left-/center-/right- justified text, colored text, and colored backgrounds, and bulleted/numbered text.

4. To switch back to math, type control-R (on Macintosh, command-R). Alternatively you can use the Maple menu Insert->2-D Math.

Document after control-T (or Insert->Text).
Document with a mixture of text and math

The user typed the text, then did control-R (command-R) and entered the F = G... formula in math mode. The user got the subscripted \( m \) by typing an underscore _ after the \( m \) to get Maple to descend to subscripts, then used the right-arrow key to ascend back up to the main level of the expression. A similar alternating between text mode and math mode allowed entry of the second sentence. No use of underscores was necessary in the second sentence because \( m_1 \) and \( m_2 \) aren't written with any subscripts.

Note that Tools->Spellcheck (alternatively, the F7 key) will run a spelling check on the non-math part of your document.

It is possible to mix text and clickable calculations in a paragraph. Typing control-= (command-=) when the cursor is in a math expression will cause Maple to print an “=” and then the result of evaluating the expression on the same line. This is an alternative to hitting the enter key and allows those kinds of calculations to be mixed with text.

countrol-= puts the results of a calculation in the midst of text.

The user entered text, then did a control-R (command-R), then entered the math expression and then typed control-=. After the calculation result appeared, they typed control-T and entered the remainder of the sentence.

4.3 Labels and assignments: remembering results for future use.

Labels

Whenever you enter an expression and then hit enter you are telling Maple, "Evaluate this expression (do any arithmetic or function calculations it specifies) and print out the result you get". The results are automatically labeled by Maple, given a bold face number (of the form \( X \) or a segmented label such as \( XX.YY.ZZ \). You can refer to the results by the Maple menu Insert->Label and then typing in the number. The keyboard shortcut for this is control-L (command-L on Macintosh).
### Labeled results

<table>
<thead>
<tr>
<th>Maple work</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>$5!$</td>
<td>Compute a result</td>
</tr>
<tr>
<td></td>
<td>Compute another result</td>
</tr>
<tr>
<td></td>
<td>Add them together</td>
</tr>
<tr>
<td>$4!$</td>
<td>Find the ratio of the two results.</td>
</tr>
<tr>
<td>$(1.3.1.1) + (1.3.1.2)$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>$(4.2)$</td>
</tr>
<tr>
<td>$(1.3.1.1)$</td>
<td></td>
</tr>
<tr>
<td>$(1.3.1.2)$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>$(4.3)$</td>
</tr>
<tr>
<td>$5$</td>
<td></td>
</tr>
<tr>
<td></td>
<td>$(4.4)$</td>
</tr>
</tbody>
</table>

#### Assignment to a name, evaluation

The Maple operator `:=` (colon immediately followed by an equals) assigns a value to a name. After that point in time, if you do a calculation with an expression that uses the name, the assigned value is used.

When you enter an expression in Math mode (even if it's just a name, without any arithmetic), you ask Maple to evaluate what you enter. Maple also (before it does anything else) figures out the values assigned to names that appear in the expression. Then it does arithmetic, function calculation, and any other operations you've described in the expression.
Assignment

<table>
<thead>
<tr>
<th>Examples of assignment with :=</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>( p := x^2 + x + ax + 5 )</td>
<td>We assign the name ( p ) the value of the expression</td>
</tr>
<tr>
<td>( x^2 + x + ax + 5 )</td>
<td>If we enter an expression containing ( p ), its value is plugged in for the calculation of the result.</td>
</tr>
<tr>
<td>( p + 1 )</td>
<td>Here we assign the name ( x ) the value 3.</td>
</tr>
<tr>
<td>( x^2 + x + ax + 6 )</td>
<td>If we now do a calculation with ( p ) (here all we ask is for Maple to calculate the current value of ( p )), the value of ( x ) is used since ( p )'s value mentions ( x ). Thus there may be a chain of assignments that Maple must look at.</td>
</tr>
<tr>
<td>( x := 3 )</td>
<td>Solving the result 1.1.2.4 for ( a ) can be gotten by right clicking that expression.</td>
</tr>
<tr>
<td>( 3 )</td>
<td>We change the value of ( x ) by assigning it a different value.</td>
</tr>
<tr>
<td>( p )</td>
<td>When we do another calculation with ( p ), the most recent assigned value of ( x ) is used.</td>
</tr>
<tr>
<td>( 17 + 3a )</td>
<td>We can undo the connection between ( x ) and any value by unassigning ( x ). This operation produces no output, so no label. We can barely tell that it has happened.</td>
</tr>
<tr>
<td>( a = \frac{-17}{3} )</td>
<td>( p ) still has a value, but since ( x ) no longer has a value, we are back to the original result.</td>
</tr>
<tr>
<td>( x := 4 )</td>
<td></td>
</tr>
<tr>
<td>( 4 )</td>
<td></td>
</tr>
<tr>
<td>( p )</td>
<td></td>
</tr>
<tr>
<td>( 25 + 4a )</td>
<td></td>
</tr>
<tr>
<td>( a = \frac{-25}{4} )</td>
<td></td>
</tr>
<tr>
<td>( p )</td>
<td></td>
</tr>
<tr>
<td>( x^2 + x + ax + 5 )</td>
<td></td>
</tr>
<tr>
<td>( (4.5) )</td>
<td></td>
</tr>
<tr>
<td>( (4.6) )</td>
<td></td>
</tr>
<tr>
<td>( (4.7) )</td>
<td></td>
</tr>
<tr>
<td>( (4.8) )</td>
<td></td>
</tr>
<tr>
<td>( (4.9) )</td>
<td></td>
</tr>
<tr>
<td>( (4.10) )</td>
<td></td>
</tr>
<tr>
<td>( (4.11) )</td>
<td></td>
</tr>
<tr>
<td>( (4.12) )</td>
<td></td>
</tr>
<tr>
<td>( (4.13) )</td>
<td></td>
</tr>
</tbody>
</table>

Assignment is a feature common to many programming languages. In some languages "\( := \)" is used for the assignment operation. In others plain equals "\( = \)" is used. Maple uses "\( := \)" because it uses "\( = \)" for equations. It would be confusing to use the same symbol for two common but different operations.
= and := mean different things in Maple

<table>
<thead>
<tr>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>( a := 3 )</td>
<td>We assign ( a ) the value 3. This is an equation. It doesn't assign ( x ) any value.</td>
</tr>
<tr>
<td>( x := 4 )</td>
<td>We assign ( p ) the value of the expression ( a + x ). ( a ) stands for the value 3 at this point since we did an assignment to it. ( x ) is just a symbol that has no assigned value. We can do an assignment to ( x ). This time ( p )'s value is 3 + 47.</td>
</tr>
<tr>
<td>( p := a + x )</td>
<td>3 + x (4.16)</td>
</tr>
<tr>
<td>( x := 47 )</td>
<td>47 (4.17)</td>
</tr>
<tr>
<td>( p := a + x )</td>
<td>50 (4.18)</td>
</tr>
</tbody>
</table>

4.4 The structure of information in Maple: getting information from solve

The result of the solve operation can have multiple parts if there are multiple solutions to the equation. We can select each part by giving an index (either 1 or 2).

\[ eq1s := 3 \cdot x = x^2 - 28 \]
\[ 3 \cdot x = x^2 - 28 \quad \text{solve} \rightarrow \{ x = -4 \}, \{ x = 7 \} \quad \text{select entry 1} \rightarrow \{ x = -4 \} \]

\[ eq2s \quad 3 \cdot x = x^2 - 28 \quad \text{solve} \rightarrow \{ x = -4 \}, \{ x = 7 \} \quad \text{select entry 2} \rightarrow \{ x = 7 \} \]

If we give solve a linear equation, it has only one solution. We can still select the first entry.

\[ eq2s := 3 \cdot x = 28 \quad \text{solve} \rightarrow \{ x = \frac{28}{3} \} \quad \text{select entry 1} \rightarrow x = \frac{28}{3} \]

If we do "solve for \( x \)" for the same equation, we see that the answer comes back in a slightly different form. But it still has parts.
Maple (as well as many other programming languages) can compute with objects that have structure. Here are three different kinds of structures that Maple can handle:

### Basic data structures in Maple

<table>
<thead>
<tr>
<th>Type of structure</th>
<th>What they look like</th>
<th>Examples</th>
<th>Access (Select-&gt;i on right-click/control-click menu also works for access)</th>
<th>Empty structure value</th>
</tr>
</thead>
</table>
| Sequences         | Values separated by a comma | 19, 47, 92  
|                   |                     | 19, 47, 92  
|                   |                     | (1.4.3)[1]  
|                   |                     | 19 (4.2)  
|                   |                     | (1.4.3)[−1]  
|                   |                     | 92 (4.2)  
|                   |                     | (1.4.3)[1..2]  
|                   |                     | 19, 47 (4.2)  |
| Lists             | A sequence surrounded by square brackets [ ] | MyData := [1.0, x, 3/4, a]  
|                   |                     | [1.0, x, 3/4, a] (4.2)  
|                   |                     | MyData[2]  
|                   |                     | x (4.2)  
|                   |                     | MyData[5]  
|                   |                     | Error, invalid subscript selector  
|                   |                     | MyData[2..4]  
|                   |                     | [x, 3/4, a] (4.2)  
|                   |                     | [ ] (4.2)  
| Sets              | A sequence surrounded by curly braces { } | Scores := {3, 7, 10}  
|                   |                     | {3, 7, 10} (4.2)  
|                   |                     | Scores[1]  
|                   |                     | 3 (4.2)  
|                   |                     | Scores[−3]  
|                   |                     | 3 (4.2)  
|                   |                     | Scores[−4]  
|                   |                     | Error, invalid subscript selector  |

For the time being, we just want you to recognize the different kinds of structures that are output by `solve` and other functions and be able to select parts from them. Later on we will get a lot of work done by performing computations with them.
Consider the problem you did in Lab 1, along with a solution:

**Version 1 and solution**

From Anton, *Calculus*, 8th edition, ch. 1 review exercises, problem 37, p. 99. A breeding group of 20 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, $N$, after $t$ years will be given by the formula:

$$N = \frac{220}{1 + 10 \cdot (0.83)^t}$$

and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 80. (a) Graph $N$ versus $t$. (b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work. (c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of $t$.)

(a) We do this by drawing the graph for a large enough value of $t$ and seeing what happens.

(b) Solve for $t$ when $N = 80$.

$$80 = \frac{220}{1 + 10 \cdot 0.83^t} \quad \text{solve} \quad t = \frac{\ln \left( \frac{220}{80} \right)}{\ln(0.83)} \approx 9.354227718$$
Alternatively (this is optional) we can do a little calculus and take the limit of the expression as \( t \) goes to infinity.

\[
N = \frac{220}{1 + 10 \cdot (0.83)^t} \quad \text{right hand side} \quad \frac{220}{1 + 10 \cdot 0.83^t} \quad \text{limit} \quad 220.
\]

We can imagine ourselves working as a environmental engineer for the National Forest Service and being very pleased with ourselves for solving the problem with Maple. But now we are handled two more problems to do:

**Version 2**

A breeding group of 33 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, \( N \), after \( t \) years will be given by the formula:

\[
N = \frac{330}{1 + 10 \cdot (0.79)^t}
\]

and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 85.

(a) Graph \( N \) versus \( t \). (b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work.

(c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of \( t \)).

**Version 3**

A breeding group of 45 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, \( N \), after \( t \) years will be given by the formula:

\[
N = \frac{450}{1 + 10 \cdot (0.63)^t}
\]

and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 90.

(a) Graph \( N \) versus \( t \). (b) How many years must the state of Montana maintain a program to care for the sheep? Show your work.

(c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of \( t \)).

We have the feeling that we will shortly be handed problems for a number of other locations as well. How can we reuse our original work with minimal effort?
If we had the first solution, we could produce the second solution through *copy-paste-edit-re-execute*:

<table>
<thead>
<tr>
<th>Executing a clone of a script through copy-paste</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Copy and paste the original solution into a new document, or to a spot later in the same document. You do this as with a word processor – select a region of the worksheet with the mouse, type control-C (command-C on a Mac). Then position the document cursor in the destination, and type control-V (command-V on a Mac). A duplicate of the solution should appear there.</td>
</tr>
<tr>
<td>2. Using the mouse, edit the formulae as needed. You only need to edit the black (input) formulae, not the blue ones.</td>
</tr>
<tr>
<td>3. Position the mouse at the first computation and hit enter. Continue to work your way through the sequence of the commands.</td>
</tr>
<tr>
<td>4. Alternatively, select the entire region containing the edited version of the solution and hit Edit-&gt;Execute-&gt;Selection.</td>
</tr>
</tbody>
</table>

The results of executing the edited script are *A breeding group (page 51)*. It is not totally correct. We will have to change a few things by hand: the clickable operation "evaluate at a point" in step (b) will use N=80 (which is what the copy says) instead of N=85, so we will have to redo it. Also, the last plot will not show an appropriate vertical range unless we do that. We'd like to do a little less of this hand-tuning in re-execution. Also, we'd like to make it easier to remember what to change between multiple versions.

*A breeding group (page 52)*

### 4.6 Rewriting the script using labeling and assignment

While copying and editing is probably a little faster than typing in the whole script again, we can reduce the amount of hunting around for changes by writing a script finding the parameters of the problem, and writing the script so that it assigns values to the parameters at the beginning of the problem.

**Finding and naming parameters**

You can find parameters if you have several versions of a problem by looking at what changes in the formulas from version to version. This only works if you have solved the at least one version of the problem first. For example, in the sheep problem, we note the following things changing. We pick names for these.

1. the numerator of the "sheep equation" (P)
2. the coefficient in the denominator of the equation (c)
3. the value of the stable population (s)

The other number in the script is the original population of the sheep. We realize that it can be derived by evaluating the "sheep equation" at t=0. Thus this value does not need to be a parameter as we can derive it from the other information. It might be a good check though. We then write the script to assign values to the parameters at the start of the script, and then write the other operations and expressions in terms of the symbols.

This allows us to redo the script just by changing the values at the beginning of the script. We use the word processing features to add extra directions to make the script easier to use, basically saying "here, change these things", and "this is the end of where you should stop copying".

The result of executing the script is ???.

Having created this script, we can handle the third version of the problem by editing the values of the parameters and executing the script again by selecting the entire script with the mouse, and then doing Edit->Execute->Selection. We get this result:

**Note:** a "bug" in Maple 13 causes duplicate graphs to sometimes appear during re-execution of the script. It's easy enough to delete the redundant copies.
4.7 Summary of script writing

Script writing is appropriate when you expect to handle several different versions of the same problem. In professional work, this is often the case -- if it's worth doing at all, it's probably going to occur more than once.

Don't try to write a script before you've figured out how to do the problem! It may be possible to tweak a script a bit if it doesn't work exactly right initially, but if you'll just be scripting garbage if your initial thoughts are far away from what you really want.

Once you have a worksheet of instructions for one version of the problem look at it and the other versions and find the parameters. Set up a new worksheet where the first thing you do is to assign values to the parameters. Then work through the rest of the instructions and rewrite them to use the parameters instead of the fixed values from one version of the problem.

4.8 Troubleshooting scripts

Programming books have the tendency to show things that work. They say less about what to do about the things that don't work. However, it is usually the case that computer users often spend more time "getting things to work" than "working". Learning how to get out of jams is at least as valuable as knowing how to enter operations and what they mean. We offer this advice, which is "commonsense about work" as applied to interactive software development:

1. Know how to solve the problem before you start scripting. Iif you have only fuzzy notions about the math or the operations you want to proceed, your computer work will just amplify that. Where does this plan come from? If you are lucky, the solution may be told to you. But the big bucks, as they say, go to those who can devise the solution plan themselves. 2. Break the actions into small steps. If you get into trouble, you will be able to nip it at the bud. This becomes a more prominent tactic in later work when we are tempted to construct long-winded one-line expressions that do everything at once.

3. Test pieces individually, then put them together. For example, if you don't really understand how to make a dotted line plot in teal with a title, you should try to do that with a simple plot (such as $x^2$ ) rather than an expression whose shape you aren't that familiar with it. Then take what works and substitute the real expression you want to plot in a copy of the $x^2$ plot operation. If you think about it, this is similar to what happened in Fall 2009 ENGR 101 Lab 2, where they first had you learn how to trigger an oscilloscope with the output of the function generator, rather than the output of the camera/flash sensor. The complexity of troubleshooting is reduced if you half as many unknowns to worry about. This can be called divide and conquer troubleshooting.

4. Match parentheses. If you're building an expression that has parentheses, make sure that the number of beginning parentheses is equal to the number of closing parentheses. You can do this by counting! If you have more ( than ), then look in the expression to see where the missing one might be. 5. If what you have doesn't work, find something similar which does work, and then incrementally edit it. For example, if you can't get $a := x^2 + 3 \cdot x + 1$ in, then first see whether you can get $a := 1$ to work. Once you succeed with that, edit the expression to $a := 3 \cdot x + 1$ and so forth.

6. If strange things continue to happen despite your best efforts to troubleshoot, it may be that previous settings in the Maple session are interfering with your current work. Recall that some people in the ENGR101 lab couldn't get their oscilloscopes to work because of settings change in the oscilloscopes by groups earlier in the day. This can be particularly true if you are developing scripts and are assigning parameter values, then switch to development of another script in the same document. The values you assigned will not magically unassign themselves when you start working on something new in the same worksheet. The remedy for this is: open a new Maple document (File->New->Document). If you really know what you are doing, you can use the unassign operation (first mentioned here), or the restart operation (an advanced command).
4.9 Attachments

Attachment: Version 2 of sheep script (slightly incorrect), without parameters

A breeding group of 30 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, $N$, after $t$ years will be given by the formula:

$$N = \frac{330}{1 + 10 \cdot (0.79)^t}$$

and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 85. (a) Graph $N$ versus $t$. (b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work. (c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of $t$.)

(a) $N = \frac{330}{1 + 10 \cdot (0.79)^t} \quad \text{right hand side} \quad \frac{330}{1 + 10 \cdot 0.79^t} \quad \rightarrow \quad \# \text{ of sheep versus time}$

(b) $N = \frac{330}{1 + 10 \cdot (0.79)^t} \quad \text{evaluate at point} \quad 80 = \frac{330}{1 + 10 \cdot 0.79^t} \quad \text{solve} \quad 4.934410722$

(c) $N = \frac{330}{1 + 10 \cdot (0.79)^t} \quad \text{right hand side} \quad \frac{330}{1 + 10 \cdot 0.79^t} \quad \rightarrow$
Alternatively (this is optional) we can do a little calculus and take the limit (left-sided limit) of the expression as \( t \) goes to infinity.

\[
N = \frac{330}{1 + 10 \cdot (0.79)^t} \quad \text{right hand side} \quad \frac{330}{1 + 10 \cdot 0.79^t} \quad \text{limit} \quad 330.
\]

**Attachment: Version 2 of sheep script (corrected), without parameters**

**Version 2 of sheep problem, with edited script**

A breeding group of 30 bighorn sheep is released in a protected area in Colorado. It is expected that with careful management the number of sheep, \( N \), after \( t \) years will be given by the formula:

\[
N = \frac{330}{1 + 10 \cdot (0.79)^t}
\]

and that the sheep population will be able to maintain itself without further supervision once the population reaches a size of 85. (a) Graph \( N \) versus \( t \). (b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work. (c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of \( t \).)

\[
(a) \quad N = \frac{330}{1 + 10 \cdot (0.79)^t} \quad \text{right hand side} \quad \frac{330}{1 + 10 \cdot 0.79^t} \quad \rightarrow
\]
Alternatively (this is optional) we can do a little calculus and take the limit (left-sided limit) of the expression as \( t \) goes to infinity.

\[
N = \frac{330}{1 + 10 \cdot (0.79)^t}
\]

\[
\begin{align*}
\text{evaluate at point} & \quad 85 = \frac{330}{1 + 10 \cdot 0.79^t} \\
\text{solve} & \quad 5.277302835
\end{align*}
\]

\[
N = \frac{330}{1 + 10 \cdot (0.79)^t}
\]

\[
\begin{align*}
\text{right hand side} & \quad \frac{330}{1 + 10 \cdot 0.79^t} \\
\text{limit} & \quad 330
\end{align*}
\]

**Attachment: Version 2 of Sheep Script, with parameters**

**Start of parameters -- change these for each version of the problem**
We call the size of the stable population \( s \).

\[
\begin{align*}
\text{End of parameters} & \quad (4.36) \\
\text{(a) Graph } N & \text{ versus } t \, . \, \text{(b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work. (c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of } t \, . \) & \\
\text{(a)} & \\
\text{To make the graphing work all the time, we set the vertical axis to } "P+30" \text{ rather than a fixed value. This will set the vertical axis so that it will be 30 more than the value of } P \text{ which from the first problem we have realized is the top of the graph.} & \\
sheepEquation & \\
N &= \frac{\text{330}}{1 + 10 \cdot 0.79^t} & (4.37) \\
\text{right hand side} & \\
& \frac{\text{330}}{1 + 10 \cdot 0.79^t} & (4.38)
\end{align*}
\]
(b) Finding the time requires substituting the value of $s$ for $N$ in the equation, and then solving the resulting equation for $t$.

\[
sheepEquation \quad N = \frac{330}{1 + 10 \cdot 0.79^t} \quad \text{evaluate at point} \quad 85 = \frac{330}{1 + 10 \cdot 0.79^t} \quad \text{solutions for } t \quad 5.277302835 \quad \text{solve} \quad 5.277302835
\]

Alternatively (this is optional) we can do a little calculus and take the limit (left-sided limit) of the expression as $t$ goes to infinity.

\[
sheepEquation
\]

\[
N = \frac{330}{1 + 10 \cdot 0.79^t}
\]

\[
\text{right hand side}
\]

\[
\frac{330}{1 + 10 \cdot 0.79^t}
\]

\[
\lim
\]

\[
330.
\]

End of script

Attachment: Version 3 of Sheep Script, with parameters

Version 3 with edited parameters and re-execution
Start of parameters -- change these for each version of the problem

\[ P \equiv 450 \]

\[ c \equiv 0.83 \]

\[ \text{sheepEquation} \equiv N = \frac{P}{1 + 10^{-c^t}} \]

\[ N = \frac{450}{1 + 10^{0.83^t}} \]

We call the size of the stable population \( s \).

\[ s \equiv 100 \]

End of parameters

(a) Graph \( N \) versus \( t \). (b) How many years must the state of Colorado maintain a program to care for the sheep? Show your work. (c) How many bighorn sheep can the environment in the protected area support? (hint: examine the graph for large values of \( t \).)

(a)

To make the graphing work all the time, we set the vertical axis to "P+30" rather than a fixed value. This will set the vertical axis so that it will be 30 more than the value of \( P \) which from the first problem we have realized is the top of the graph.

\[ \text{sheepEquation} \]

\[ N = \frac{450}{1 + 10^{0.83^t}} \]
(b) Finding the time requires substituting the value of \( s \) for \( N \) in the equation, and then solving the resulting equation for \( t \).

\[
\text{sheepEquation} \quad N = \frac{450}{1 + 10 \, 0.83^t} \quad \text{evaluate at point} \quad 100 = \frac{450}{1 + 10 \, 0.83^t} \quad \text{solutions for } t \quad 5.634221548 \quad \text{solve} \quad 5.634221548
\]

Alternatively (this is optional) we can do a little calculus and take the limit (left-sided limit) of the expression as \( t \) goes to infinity.

\[
\text{sheepEquation}
\]

\[
N = \frac{450}{1 + 10 \, 0.83^t}
\]

(4.50)

\[
\text{right hand side}
\]

\[
\frac{450}{1 + 10 \, 0.83^t}
\]

(4.51)

\[
\lim_{t \to \infty} \frac{450}{1 + 10 \, 0.83^t}
\]

450.

(4.52)

End of script

Note: a "bug" in Maple 13 causes duplicate graphs to sometimes appear during re-execution of the script. It's easy enough to delete the redundant copies.
4.10 Summary of Chapter 4 material

<table>
<thead>
<tr>
<th>Important word processing operations in Maple worksheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Switch entry to 2D Math mode</td>
</tr>
<tr>
<td>Switch entry to Text mode</td>
</tr>
<tr>
<td>Switch entry to Label mode</td>
</tr>
<tr>
<td>Evaluate</td>
</tr>
</tbody>
</table>

**Assignment**

<table>
<thead>
<tr>
<th>General form</th>
<th>Examples</th>
</tr>
</thead>
</table>
| symbol name := expression | $x := 5$
| | $5$ (453) |
| | $y := z + \frac{x^2}{2}$
| | $z + \frac{25}{2}$ (454) |
| | $mySalary := (1.10.1)$
| | $+ 2.1e4$
| | $21005.$ (455) |
| | $myList := [a, b, x, y]$ |
| | $[a, b, 5, z + \frac{25}{2}]$ (456) |

**Unassignment**

<table>
<thead>
<tr>
<th>General form</th>
<th>Examples</th>
</tr>
</thead>
</table>
| unassign('symbol name ') | $x + 1$
| | $6$ (457) |
| unassign('x') | $x + 1$
| | $x + 1$ (458) |

**Type of structure**

<table>
<thead>
<tr>
<th>What they look like</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic data structures in Maple</td>
<td>Access (Select-&gt;i on right-click/control-click menu also works for access)</td>
</tr>
<tr>
<td>Type of structure</td>
<td>What they look like</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Sequences</td>
<td>Values separated by a comma</td>
</tr>
<tr>
<td>Lists</td>
<td>A sequence surrounded by square brackets [ ]</td>
</tr>
<tr>
<td>Sets</td>
<td>A sequence surrounded by curly braces { }</td>
</tr>
</tbody>
</table>

**Scripts**

Creating a script

In a Maple worksheet, take a problem and solve it using the clickable interface or through textual operations.

Note similarities and differences between different versions of the problem and find parameters.

Assign the parameters at the beginning of the script. Rework the rest of the script so that the formulas refer to the parameters by name, rather than the values used in the original version of the problem.
| Using a script | Copy and paste the script to a new location  
                           | Edit the assignments to reflect the new version of the problem.  
                           | Edit-&gt;Execute-&gt;Selection, or just hit enter (return on Macintosh) multiple times to perform the operations in the new version of the script. |
|----------------|--------------------------------------------------------------------------------|
| Rationale for using scripts | More work to do than clickable interface the first time. Saves time if you expect to want to reuse the operations on multiple versions of the same problem. |
Index

Symbols
! (exclamation point factorial), 10
(, 9
), 9
- (minus or dash), 10
:=, 43
= (equation), 18
^ (caret), 10

A
addition (+), 9
algebraic unknown, 32
arc cosine, 22
arc sine, 22
arc tangent, 22
arithmetic, 8
approximate, 23
calculator-style, 33
exact, 11
operations, 9
assignment, 19, 43
asterisk, 9
autosaving, 17
Axiom, 5

B
backspace key, 13
backups
retrieving, 17
brackets, 46

C
C (the programming language), 5
C++ (the programming language), 5
caret (power), 10
circle-X, 7
Colorado, 47
comma, 46
command-=, 42
command-C, 49
command-C (copy operation), 14
command-L, 42
command-R, 41–42
command-T, 41
command-V, 49
command-V (paste operation), 14
command-X (cut operation), 14
crash Maple, 17
curly braces, 46
cut (editing operation), 14

dashed rectangle, 7
decimal point, 31
digits, 23
divide and conquer, 50
division (/), 9
documentation
need for, 2
dot centered, 11

E
e symbolic constant, 32
Edit->Execute->Selection, 49
empty list, 46
ENGR101, 50
enter, 41, 49
equation, 18
error
invalid fraction, 13
invalid matrix/vector product, 12
invalid sequence, 13
invalid sum/difference, 12
logic, 16
missing operation, 12
numeric exception: division by zero, 12

61
rounding, 33
unable to match delimiters, 12–13
vocabulary, 15
error message, 11
evaluate, 42
   at a point, 49
evaluate and display in-line (control-=), 32
evaluating
   state, 17
evaluation
   of expressions, 8
exponentiation, 14
expressions
   algebraic, 18
   from palette, 22
F
factor, 18
factorial (!), 10
fence post error, 25
File->New->Document, 50
find something similar, 50
Fortran, 5
fraction, 31
fuzzy notions, 50
G
gigaflop, 3
graphical user interface (GUI), 4
GUI, 4
H
help
   quick, 7
I
i
   imaginary number, 32, 37
index, 45
infinity, 32, 48
Insert->2-D Math, 41
Insert->Label, 42
Insert->Text, 41
integer, 31
interactive, 5
inverse trig functions, 22
J
Java, 5
L
label, 9, 42
left arrow key, 13
left hand side (right-click menu), 24, 28
linear algebra, 12
list, 46
logic error, 16, 25
Los Alamos National Laboratory, 3
M
Macsyma, 5
Maple, 4
   as a word processor, 41
document mode, 7
Maple 13, 4
match parentheses, 50
math entry mode, 41
Mathematica, 5–6
mathematical model, 1
Matlab, 5, 38
   Symbolic Toolkit, 6
maxdigits, 15
minus, 9
mistake
   typographical
      how to fix, 13
multiple systems, 6
multiplication (*), 9
N
National Forest Service, 48
negation (-), 10
number
   exact, 33
   floating point, 33
   limited precision, 33
numbers
   exact, 31
   limited-precision, 31
   whole, 31
O
Oak Ridge National Laboratory, 3
Octave, 5
oscilloscope, 50
P
palette, 22
   Common Symbols, 32
   Expression, 32
   square root, 22
parameter, 49
parentheses, 9
paste (editing operation), 14
petaflop, 3
Pi
    symbolic constant, 32, 35
pick names, 49
PlotBuilder, 21
plotting, 19
plus, 9
power (^), 10
precision
    fixed, 33
Python, 5–6, 38

R
radian, 32
ready
    Maple, 17
rectangle
    dashed (entry), 7
restore, 17
retrieving
    a Maple session, 16
return, 41
reuse
    of software, 2
right hand side (of equation), 23
right hand side (right-click menu), 24, 28
right-click, 18
right-click->solve, 36
right-click->solve->numerically, 36
rounding, 33

S
Sage, 5
Saving
    a Maple document, 16
scientific notation, 33
scripting, 47
select
    entry, 45
select entry (right-click menu), 24, 28
sequence, 13, 46
set, 46
sheep, 47
simulation, 1
slash, 9
small steps, 50
solve, 45
    by right-clicking or control-clicking, 18
    numerical, 23
square root
    from palette, 22
state display
    of Maple, 17

T
teraflop, 3
test, 50
text entry mode, 41
Tools->Spellcheck, 42
troubleshooting, 50

U
unassign, 44, 50
underscore, 42

V
Vancouver stock exchange, 39
visualization, 1